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1 Preface
This manual describes in detail how to operate the Nintendo NITRO-System 3D Material Editor (hereafter 
referred to as 3D Material Editor). Refer to this manual if you are using the 3D Material Editor for the first 
time, or if you want details of operation methods.

1.1 Conventions Used in this Manual
This manual uses the following conventions.

1.1.1 Cautions and Hints
Descriptions that urge caution are noted with a block labeled “Caution.”

Caution: Description that urges caution.

Supplementary items or hints are noted with a block labeled “Hint.”

Hint: Supplementary description or hint.

1.1.2 Menu Names and Command Names
Menu names are expressed as “Menu Name”; command names are expressed as “Command Name”.

Command names that appear in a pop-up submenu are expressed as “Submenu Name” −> “Command 
Name” (Table 1-1).
Table 1-1 - Expressing Menu Names and Command Names

1.1.3 Key Binding
The + mark indicates key binding (key combinations) (Table 1-2).
Table 1-2 - Key Binding Notation

Menu Example Expression

“Undo” on the “Edit” menu

“Toolbar” −> “Standard” on the “View” menu

Key Binding Example Notation

Hold down the Ctrl key and press the S key Ctrl + S

Hold down the Ctrl key and the Shift key and press the Tab key Ctrl + Shift + Tab
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2 Setup
This chapter describes how to install the 3D Material Editor. It also describes the 3D Material Editor’s folder 
organization.

2.1 Installation
Use the following procedure when installing the 3D Material Editor for the first time.
1. Copy Files

Copy the NNS_3DMaterialEditor folder to any location on the hard disk.

2. Set Environment Variables

Add NNS_3DME_ROOT to the PC’s user environment variable. Specify the path to the folders that you 
copied in the previous step.

For example, if you copy the NNS_3DMaterialEditor folder to C:\Program Files, the 
environment variable will be C:\Program Files\NNS_3DMaterialEditor.

For details on setting the environment variable, see "2.1.1 Setting the Environment Variables" on page 4.

3. Make Shortcut Files

NNS_3DmaterialEditor\NNS_3DMaterialEditor.exe is the 3D Material Editor’s executable 
file. If you need a shortcut to this file, create one in a convenient location.

Hint: The 3D Material Editor does not use the Windows registry.

When upgrading a previously installed version, copy the NNS_3DMaterialEditor folder over the 
existing installation folder. The graphic scene data and initial setting information from the previous version 
will be retained in the new version.

Note: If you delete the existing installation folder when upgrading, your graphic scene data and initial set-
ting information will be deleted.
© 2004-2005 Nintendo 3 NTR-06-0081-001-A8
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2.1.1 Setting the Environment Variables
The following procedure sets the environment variables. Windows 2000 is used as an example.
1. Open System Properties and click the “Environment Variables” button on the “Advanced” tab (Figure 

2-1).

You can display System Properties by double clicking “System” in Control Panel, or by selecting 
Properties in “My Computer” on the Desktop.

Figure 2-1 - Setting the Environment Variables: 1

2. The Environment Variables dialog box will appear. Click the “New” button on User Environment 
Variables (Figure 2-2).
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Installation
Figure 2-2 - Setting the Environment Variables: 2

3. The New User Variable dialog box will appear. Set NNS_3DME_ROOT as the Variable Name, and set 
the path to the NNS_3DMaterialEditor folder as the Variable Value (Figure 2-3).

Figure 2-3 - Setting the Environment Variables: 3
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4. NNS_3DME_ROOT will be added to the user environment variables (Figure 2-4). Click the OK button to 
complete the setting.

Figure 2-4 - Setting the Environment Variables: 4
NTR-06-0081-001-A8 6 © 2004-2005 Nintendo
Released: July 19, 2005



Uninstall
2.2 Uninstall
To uninstall, delete the folder that you copied when you installed the software. Also delete the user 
environment variable NNS_3DME_ROOT that you added.

2.3 Folder Organization
Figure 2-5 shows 3D Material Editor’s folder organization.

Figure 2-5 - 3D Material Editor Folder Organization

\NNS_3DMaterialEditor

\Models

\CGToolWork

\PreviewData

\GraphicsScene

\ViewerSetting
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• NNS_3DMaterialEditor Folder

The files in this folder are required for running the 3D Material Editor:

The executable file NNS_3DMaterialEditor.exe

Library files required when the program runs (.dll)

Supplemental tools for internal processing (.exe)

• CGToolWork Folder

This folder is used to work in conjunction with 3DCG tool plug-ins. The 3D Material Editor uses this 
folder internally. Do not edit or change it. For information on working with 3DCG tool plug-ins, see "10 
Working with 3DCG Tool Plug-ins" on page 135.

• GraphicsScene Folder

This folder is for managing Graphics Scene Data. The 3D Material Editor uses this folder internally. Do 
not edit or change it. For information on Graphics Scene Data, see "4 Graphics Scene Data" on page 13.

• PreviewData Folder

This is used for communications with NITRO-Viewer. The 3D Material Editor uses this folder internally. 
Do not edit or change it. For information on communications with NITRO-Viewer, see "9 
Communications with NITRO-Viewer" on page 121.

• ViewerSetting Folder

This is used for managing NITRO-Viewer settings. The 3D Material Editor uses this folder internally. Do 
not edit or change it. For details of NITRO-Viewer settings, see "9.3 NITRO-Viewer Settings" on page 
123.

• Models Folder

This is a static model control folder displayed in NITRO-Viewer. The 3D Material Editor uses this folder 
internally. Do not edit or change it. For information on static models, see "9 Communications with 
NITRO-Viewer" on page 121.
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3 Overview
The 3D Material Editor application runs on Windows. This chapter gives an overview of the 3D Material 
Editor. It also describes its main features and window organization.

3.1 What is the 3D Material Editor?
In the Nintendo NITRO-System you can use NITRO intermediate file output plug-ins to output NITRO inter-
mediate files containing information such as model and animation model data that was created with 3DCG 
tools.

Basically, you can output two types of NITRO intermediate files from 3DCG tools:

• Model data files (imd files)

• Animation files (ica, iva, ima, itp, ita files)

The 3D Material Editor handles NITRO intermediate files. It can edit and save imd file material settings. 
Additionally, it is possible to communicate with NITRO-Viewer (supplied with the Nintendo NITRO-System) 
to display imd file models and check animation file animations (Figure 3-1).

Figure 3-1 - 3D Material Editor Overview

The 3D Material Editor works in conjunction with a 3DCG tool plug-in in order to load NITRO intermediate 
files efficiently.

Because it works in conjunction with 3DCG tool plug-ins, it is possible to directly transfer to the 3D Material 
Editor NITRO intermediate files such as model data and animation data files that were created with the 
3DCG tool (Figure 3-2).

imd files

ica, iva, ima, itp, ita files

NITRO Intermediate Files

3DCG Tool

NITRO intermediate
file output plug-in

• Model Data
• Animation Data

3D Material Editor

Save / Edit Material
Settings

Control Animation

NITRO–Viewer

Display Model

Confirm Animation

Communication
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For information on working in conjunction with 3DCG tool plug-ins, see "10 Working with 3DCG Tool Plug-
ins" on page 135.

Figure 3-2 - The 3D Material Editor Working in Conjunction with 3DCG Tool Plug-ins

3.2 3D Material Editor Features
The main 3D Material Editor features are as follows:

• Load imd files and display such information as model hierarchical structure and structural elements.

• Edit and save material settings in a loaded imd file.

• Merge material settings from another imd file into a loaded imd file.

• Communicate with NITRO-Viewer to preview models and animation.

The 3D Material Editor cannot do the following:

• Create a new imd file (create model data).

• Change the hierarchical structure of the model in a loaded imd file.

• Add or delete material with respect to the model in a loaded imd file.

• Create a new animation file (create animation data).

Caution: The 3D Material Editor cannot modify models, create animation, or change animation. Use a 
3DCG tool to perform this type of modification.

3DCG Tool

NITRO
Intermediate File
Output Plug-in

3D Material Editor

Direct transfer
possible

NITRO Intermediate File
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Main Window Screen Layout
3.3 Main Window Screen Layout
This is the layout of the 3D Material Editor’s main window (Figure 3-3).

Figure 3-3 - Main Window

Title Bar
The title bar displays the file name of the open imd file. An asterisk (*) will appear to the right of the 
imd file name if it has been edited and the changes have not been saved.

Menu
The basic 3D Material Editor operations are carried out from the Menu. There are some operations 
that you will not be able to execute directly from the Menu. For details on the menu, see "12.1 Menu 
List" on page 139.

Toolbar
The toolbar contains buttons that correspond to each item on the menu. When you click a toolbar 
button, you will be able to perform the same operation that you would if you had selected the corre-
sponding menu item. For details on the toolbar, see "12.2 Toolbar List" on page 143.

ToolbarSplit BarMenuTitle Bar

Animation ViewProperty ViewObject ViewStatus Bar
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Object View
Objects are displayed in this region. Use this view to select objects. For details on objects, see "6 
Objects" on page 31.

Property View
The properties of the selected object are displayed in this region. Use this view to edit properties. 
For details on properties, see "7 Properties" on page 53.

Animation View
This region is for animation operations. This view will only be displayed if an animation file has been 
loaded. For details on animation see "8 Animation" on page 99.

Status Bar
The Status Bar displays information to help the user operate.
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4 Graphics Scene Data
This chapter gives an overview of the Graphics Scene Data that the 3D Material Editor handles. It also 
describes how to manage and operate Graphics Scene Data.

4.1 What is Graphics Scene Data?
The 3D Material Editor handles information that is related to 3D graphics that NITRO graphics uses, and 
that is not directly contained in imd files, as Graphics Scene Data (Figure 4-1).

Figure 4-1 - What is Graphics Scene Data?

Graphics Scene Data includes the following setting information. For details on setting information, refer to 
"7.3 Graphics Scene Properties" on page 55.
• Settings related to Camera
• Settings related to Light
• Settings related to Toon/Highlight Shading
• Settings related to Alpha / Translucent Process
• Settings related to Fog
• Settings related to Edge Marking
• Settings related to Rendering

imd file

3D Material Editor

Graphic Scene Data

Model Information

Animation Information

Intermediate files
for animation

NITRO 3D graphics
information that is not
included in the imd file.
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3D Material Editor
4.2 Managing Graphics Scene Data
You can manage the Graphics Scene Data settings by preparing multiple Graphics Scene units. You can 
freely create and delete Graphics Scenes, and name them.

Even if there are multiple Graphics Scenes in the 3D Material Editor, only the Current Graphics Scene will 
influence the display of the loaded model. You can switch Graphics Scenes by selecting from the ones that 
you have created (Figure 4-2).

Figure 4-2 - Managing Graphics Scene Data

Hint: When you first start the 3D Material Editor, a Graphics Scene named “Default Scene” will be 
created automatically and set as the Current Graphics Scene.

Hint: The 3D Material Editor automatically manages Graphics Scene Data internally. All settings will 
be preserved, even if you restart the 3D Material Editor.

There are five types of Graphics Scene Data operation. You can perform any of these even if an imd file 
has not been loaded.
• Creating a New Graphics Scene
• Copy a Graphics Scene
• Rename a Graphics Scene
• Delete a Graphics Scene
• Switch the Current Graphics Scene

Caution: There will always be at least one Graphics Scene. If there is only one Graphics Scene, you 
will not be able to delete it.

3D Material Editor

Graphics Scene Data

Graphics Scene A

Graphics Scene B

Graphics Scene C

Graphics Scene D

Model
Settings

The Current Graphics Scene
influences model display.

Current Graphics Scene
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Managing Graphics Scene Data
4.2.1 Creating a New Graphics Scene
This creates a new Graphics Scene. A newly created Graphics Scene becomes the Current Graphics 
Scene.

Operating Procedure

1. Select “New” on the “Graphics Scene” menu. (Toolbar button: )

2. This dialog box appears for naming the new Graphics Scene (Figure 4-3). Type a name and click the 
OK button. You cannot enter a name that is the same as an existing Graphics Scene name.

Figure 4-3 - Creating a New Graphics Scene

4.2.2 Copying a Graphics Scene
This creates a Graphics Scene that has the same settings as the Current Graphics Scene. The newly 
created Graphics Scene will become the Current Graphics Scene.

Operating Procedure

1. Select “Copy (Current Graphics Scene name)” on the “Graphics Scene” menu. (Toolbar button: )

2. This dialog box appears for renaming the copied Graphics Scene (Figure 4-4). Type a name and click 
the OK button. You cannot enter a name that is the same as an existing Graphics Scene name.

Figure 4-4 - Copying a Graphics Scene
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3D Material Editor
4.2.3 Renaming a Graphics Scene
This renames the Current Graphics Scene.

Operating Procedure
1. Select “Rename (Current Graphics Scene name)” on the “Graphics Scene” menu. 

(Toolbar button: )

2. This dialog box appears for renaming the Graphics Scene (Figure 4-5). Type a name and click the OK 
button. You cannot enter a name that is the same as an existing Graphics Scene name.

Figure 4-5 - Renaming a Graphics Scene

4.2.4 Deleting a Graphics Scene
This deletes the Current Graphics Scene. If there is only one Graphics Scene, you will not be able to 
delete it. The first remaining Graphics Scene will become the Current Graphics Scene.

Operating Procedure

1. Select “Delete (Current Graphics Scene name)” on the “Graphics Scene” menu. (Toolbar button: )

2. A confirmation dialog box will appear (Figure 4-6). If you want to delete, click the OK button.

Figure 4-6 - Deleting a Graphics Scene

4.2.5 Switching the Current Graphics Scene
This switches the Current Graphics Scene.

Operating Procedure
1. Select “Switch Scene” −> “(Graphics Scene name)” on the “Graphics Scene” menu.

(Toolbar combo box: )
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Importing and Exporting isd Files
4.3 Importing and Exporting isd Files
Graphics Scene Data is automatically loaded when the 3D Material Editor is started, and saved when the 
3D Material Editor is exited. However, the user can also explicitly load or save using a NITRO intermediate 
file: Graphics Scene data file (isd file).

There are two operations for explicitly loading or saving Graphics Scene Data:
• Import an isd file, and add a Graphics Scene.
• Export each Graphics Scene as an isd file.

Figure 4-7 - Importing and Exporting isd Files

Using the isd file import/export feature, you can share the settings for a specific Graphics Scene across 
multiple 3D Material Editors (Figure 4-8).

Figure 4-8 - Standardizing Graphics Scene Settings on Multiple 3D Material Editors

isd file A

isd file B

3D Material Editor

Graphics Scene Data

Graphics Scene A

Graphics Scene B

...
Import

Export

3D Material Editor A

Shared
Graphics Scene

isd file

3D Material Editor B

3D Material Editor C

3D Material Editor D

Import

Export Import

Import
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3D Material Editor
4.3.1 Importing isd files
This imports an isd file, and adds a Graphics Scene.

Operating Procedure

1. Select “Import isd File” on the “Graphics Scene” menu. (Toolbar button: )

2. A file selection dialog box will appear (Figure 4-9). Specify the isd file to import and click the Open 
button.

Figure 4-9 - Importing an isd File
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Importing and Exporting isd Files
4.3.2 Exporting an isd File
This exports the Current Graphics Scene as an isd file.

Operating Procedure

1. Select “Export isd File” on the “Graphics Scene” menu. (Toolbar button: )

2. A file selection dialog box will appear (Figure 4-10). Specify the folder to save in and the file name, and 
click Save.

Figure 4-10 - Exporting an isd File
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5 imd Files
This chapter describes loading, saving, and merge-loading imd files.

5.1 Loading an imd File
There are two methods for loading an imd file:
• Open by specifying a file name
• Open by dragging and dropping

Caution: You can only open one imd file at a time.

5.1.1 Open by Specifying a File Name
This opens an imd file by specifying a file name in the file selection dialog box. If an imd file is already 
open, it will display a message prompting you to save it before opening the file.

Operating Procedure

1. Select “Open imd File” in the “File” menu. (Toolbar button: , Shortcut Keys: Ctrl + O)

2. The file selection dialog box will appear (Figure 5-1). Specify the file to load and click the Open button.

Figure 5-1 - Loading an imd File: Specifying a File Name
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3D Material Editor
5.1.2 Open by Dragging and Dropping
This opens an imd file by dragging and dropping. If an imd file is already open, it will display a message 
prompting you to save it before opening the file.

Operating Procedure
1. Drag an imd file and drop in anywhere in the main window (Figure 5-2).

Figure 5-2 - Loading an imd File: Dragging and Dropping

Note: If you drag and drop multiple imd files a dialog box will appear for selecting the imd file to load.

Hint: You can simultaneously load imd files and animation files by dragging and dropping them 
together. For information on loading animation files, see "8.1 Loading Animation Files" on 
page 99.

Hint: To simultaneously start the 3D Material Editor and load a file, drag and drop the file into the 3D 
Material Editor executable file (NNS_3DMaterialEditor.exe) or a shortcut file to the 
executable file.

5.2 Saving an imd File
You can resave imd file material settings that you edited with the 3D Material Editor in the imd file. There 
are two methods of doing this:
• Save by overwriting
• Name it and save

5.2.1 Save by Overwriting
This will overwrite the imd file that is currently opened.

Operating Procedure

1. Select “Save imd File” in the “File” menu. (Toolbar button: , Shortcut Keys: Ctrl + S)

imd file

(2) Drop it anywhere in the window.

(1) Drag an imd file.
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Saving an imd File
5.2.2 Name It and Save
This will name an imd file and save it.

Operating Procedure

1. Select “Save imd File As” in the “File” menu. (Toolbar button: , Shortcut Keys: Ctrl + A)

2. A file dialog box will appear (Figure 5-3). Specify the folder and the file name for saving and click the 
Save button.

Figure 5-3 - Naming an imd File and Saving It

5.2.3 Methods of Outputting Textures and Palettes
When you save an imd file, if there are textures or palettes that are not used by any material, a dialog box 
will appear for selecting the method of texture and palette output (Figure 5-4).

Figure 5-4 - Texture and Palette Output Methods

Select one of the following output methods and click the OK button.
• Output all textures and palettes
• Only output used textures and palettes
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3D Material Editor
5.2.3 3D Material Editor Special Extension Elements
Special extension elements are appended to imd files that the 3D Material Editor outputs. These are only 
for use inside the 3D Material Editor (Figure 5-5).

Figure 5-5 - Special Extension Elements Appended to the imd File: 1

All of the appended extension elements are output beneath the <ex_nns_3dme> element, which is output 
as a as child element of the <body> element. The name of the extension elements always begins with ex_ 
(Figure 5-6).

Figure 5-6 - Special Extension Elements Appended to the imd File: 2

The attribute values and child elements contained in these extension elements are special information for 
the 3D Material Editor.

If you want to parse and use the imd file contents, ignore the content that follows these extension 
elements.

imd format
Standard elements

3D Material Editor
Special extension elements

imd file

Special extension elements are
appended for use inside the 3D

Material Editor.

<body>

<ex_nns_3dme>
    <ex_****>

    </ex_****>
    <ex_****>

    </ex_****>
</ex_nns_3dme>
</body>

imd file

Extension elements appended by the
3D Material Editor
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Merge-Loading imd Files
5.3 Merge-Loading imd Files
This describes the imd file merge-load feature.

5.3.1 What is imd File Merge-Load?
The imd file merge-load feature merges (combines, mixes) material settings from another imd file into the 
imd file that is currently open.

Figure 5-7 shows the processes that occur when you merge-load imd file B into the currently open imd file A.

• If materials in files A and B have the same names, those in B will overwrite those in A. You can choose 
whether to overwrite.

• If textures in files A and B have the same names, those in B will overwrite those in A. You can choose 
whether to overwrite.

• If palettes in files A and B have the same names, those in B will overwrite those in A. You can choose 
whether to overwrite.

• Textures that are in file B but are not in file A will be added to file A.

• Palettes that are in file B but are not in file A will be added to file A.

Figure 5-7 - Merge-Loading imd Files

Material Name H

Material Name G

Material Name B

Material Name C

Palette name Y

Palette name X

Texture name O

Texture name M

Texture name P

Merge imd file (file B)

Material Name A

Material Name B

Material Name C

Texture name L

Texture name M

Palette name X

Currently open imd file (file A)

Overwrite
(selectable)

Add

Overwrite
(selectable)

Overwrite
(selectable)

Overwrite
(selectable)

Add

Add
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3D Material Editor
5.3.2 Uses for the Merge-Load Feature
When you use the 3D Material Editor to modify material settings in a model’s imd file, and subsequently 
use a 3DCG tool to edit the model’s node structure, polygons, or the like, the material settings in the new 
imd file will become those of the initial status that the 3DCG tool plug-in outputs.

In such a case, if you merge a material setting file that you have already set into the newly output imd file, 
you will be able to apply the settings to the newly output imd file (Figure 5-8).

Figure 5-8 - Uses for Merge-Load

Caution: If the names of materials or textures have been changed in the files, even if you do merge-
load, the settings will not be merged. When you edit a model with a 3DCG tool, do not 
change the names of materials or textures that you plan to merge.

5.3.3 Merge-Load Operational Procedure
Do the following to merge-load imd files.

Operating Procedure
1. Select “imd File Merge-Load” in the “File” menu. (Toolbar button: , Shortcut Keys: Ctrl + M)

2. A file selection dialog box appears (Figure 5-9). Select the imd file to merge and click the Open button.

3DCG Tool

Model A

3D Material Editor

imd file A

Edit and save material
settings.

(1) Edit imd file material settings with the 3D Material Editor.

Edited
Model A

3DCG Tool

imd file A

3D Material Editor

imd file B

(2) Edit model A with 3DCG tool

Merge completed settings
from imd file A into the
newly output imd file B.

Material settings from imd
file A will be applied to the
material in imd file B.
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Merge-Loading imd Files
Figure 5-9 - Opening the imd File to Merge-Load

3. The merge-load setting dialog box will appear (Figure 5-10). In each page of the dialog box set the 
merge-load operations that you want, then click the OK button. For details, see "5.3.4 The Merge-Load 
Setting Dialog Box" on page 28.

Figure 5-10 - The Merge-Load Setting Dialog Box
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3D Material Editor
5.3.4 The Merge-Load Setting Dialog Box
Use the Merge-Load setting dialog box to set the operations that will be carried out when you merge-load 
imd files. The dialog box contains three setting pages:
• “Material Update” page
• “Texture Update” page
• “Palette Update” page

5.3.4.1 Updating Materials
This makes settings related to material updates (Figure 5-11).

Figure 5-11 - Merge-Load Setting Dialog Box: Updating Materials

A. This list displays the materials that are candidates for overwriting. Materials that are checked will 
be overwritten. Uncheck items that you do not want to overwrite.

B. Click this button to select all of the materials in the list.

C. Click this button to uncheck all of the materials in the list.

D. This displays the number of materials that will be overwritten.

A

B

D

C
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Merge-Loading imd Files
5.3.4.2 Updating Textures

This makes settings related to texture updates (Figure 5-12).

Figure 5-12 - Merge-Load Setting Dialog Box: Updating Textures

A. This list displays the textures that are candidates for overwriting. Textures that are checked will be 
overwritten. Uncheck items that you do not want to overwrite.

B. Click this button to select all of the textures in the list.

C. Click this button to uncheck all of the textures in the list.

D. This displays a list of the textures that will be added. You cannot modify these textures.

E. This displays the number of textures that will be overwritten.

F. This displays the number of textures that will be added.

A

F

E

D

CB
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3D Material Editor
5.3.4.3 Updating Palettes
This makes settings related to palette updates (Figure 5-13).

Figure 5-13 - Merge-Load Setting Dialog Box: Updating Palettes

A. This list displays the palettes that are candidates for overwriting. Palettes that are checked will be 
overwritten. Uncheck items that you do not want to overwrite.

B. Click this button to select all of the palettes in the list.

C. Click this button to uncheck all of the palettes in the list.

D. This displays a list of the palettes that will be added. You cannot modify these palettes.

E. This displays the number of palettes that will be overwritten.

F. This displays the number of palettes that will be added.

Caution: If all of the following numbers are 0, you will not be able to merge-load. The OK button will 
be disabled.

• Number of materials that will be overwritten
• Number of textures that will be overwritten
• Number of palettes that will be overwritten
• Number of textures that will be added
• Number of palettes that will be added

A

F

E

D

CB
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6 Objects
This chapter gives an overview of the objects that are displayed in the Object View, and describes 
selection and operation.

6.1 What is an Object?
In the 3D Material Editor, items for which you can display information, edit settings, or the like are called 
objects. Table 6-1 describes the different types of objects.
Table 6-1 - Types of Objects

Materials are represented by two icons: 

 indicates materials that are not shared by multiple polygons. 

 indicates materials that are shared by multiple polygons.

6.2 The Object View
Objects are displayed in the Object View. You can select objects in the Object View. You can perform a 
number of operations on the 3D Material Editor objects that you select.

The Object View has the following view modes. The displayed object and the content of the display differ 
according to the display mode.
• Schematic View
• Tree View
• Node List View
• Polygon List View
• Material List View
• Texture List View
• Palette List View
The current display mode is displayed at the top of the Object View (Figure 6-1).

Figure 6-1 - View Mode in the Object View

Object Icon Description

Graphics Scene This handles information related to Graphics Scenes.
It maps to the Current Graphics Scene.

Model This handles overall information related to models.
It maps to the entire imd file.

Node This handles information related to nodes.
It maps to imd file <node> elements.

Polygon This handles information related to polygons.
It maps to imd file <polygon> elements.

Material  or This handles information related to materials.
It maps to imd file <material> elements.

Texture This handles information related to textures.
It maps to imd file <tex_image> elements.

Palette This handles information related to palettes.
It maps to imd file <tex_palette> elements.
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3D Material Editor
This is how to switch display modes.

Operating Procedure
1. Select “View Mode” −> “(View Mode name)” in the “View” menu. 

(Toolbar button:       , Shortcut Keys: Ctrl + 1 - Ctrl + 7)

6.2.1 Object Selection
Object selection can be performed in all display modes with the following shared operations (Table 6-2)
Table 6-2 - Object Selection

The following operations can be performed from the menu: 
• Selection of a Graphics Scene
• Selection of a Model
• Selection of All Nodes
• Selection of All Polygons
• Selection of All Materials
• Selection of All Textures
• Selection of All Palettes
• Deselection

6.2.1.1 Selecting a Graphics Scene
Selects the current graphics scene.

Operating Procedure
1. Select “Select” −> “Graphics Scene” in the “Object” menu. 

(Toolbar button: )

6.2.1.2 Selecting a Model
Selects a model.

If no imd file is loaded, nothing can be selected.

Operating Procedure
1. Select “Select” −> “Model” in the “Object” menu. 

(Toolbar button: )

6.2.1.3 Selecting All Nodes
Selects all nodes.

If there are no nodes in the model, nothing can be selected.

Operation Description

Clicking the Object Selects the object. 

Changes the focus if the object is already selected.

Ctrl + Clicking the Object Switches between selecting and deselecting the object.

Shift + Clicking the Object Selects all objects between two objects that have focus.

Dragging Selects all objects contained within the dragged region.

Clicking an Object Region Deselects an object.
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The Object View
Operating Procedure
1. Select “Select” −> “All Nodes” in the “Object” menu. 

(Toolbar button: )

6.2.1.4 Selecting All Polygons
Selects all polygons.

If there are no polygons in the model, nothing can be selected.

Operating Procedure
1. Select “Select” −> “All Polygons” in the “Object” menu. 

(Toolbar button: )

6.2.1.5 Selecting All Materials
Selects all materials 

If there are no materials in the model, nothing can be selected.

Operating Procedure
1. Select “Select” −> “All Materials” in the “Object” menu. 

(Toolbar button: )

6.2.1.6 Selecting All Textures
Selects all textures. 

If there are no textures in the model, nothing can be selected.

Operating Procedure
1. Select “Select” −> “All Textures” in the “Object” menu. 

(Toolbar button: )

6.2.1.7 Selecting All Palettes
Selects all palettes. 

If there are no palettes in the model, nothing can be selected.

Operating Procedure
1. Select “Select” −> “All Palettes” in the “Object” menu. 

(Toolbar button: )

6.2.1.8 Deselecting
Deselects an object.

Operating Procedure
1. Select “Deselect” in the “Object” menu. 

(Toolbar button: )
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3D Material Editor
6.2.2 Schematic View
This mode schematically displays a model’s hierarchical structure. Each type of object appears as a 
differently colored rectangle. The name and the icon symbol of the object appear inside the rectangle. The 
selected object is displayed in a highlight color (Figure 6-2).

Figure 6-2 - Object View: Schematic View

The objects are displayed as follows:

• Graphic Scenes

Grey rectangles

• Models

Red rectangles

• Nodes

Green rectangles
The root node is connected to the model by a straight line. Other nodes are connected to parent nodes 
by straight lines.

Model

Node

Selected Object

Polygon

Material

Palette

Texture
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The Object View
• Polygons

Light blue rectangles
Polygons are connected to the nodes that contain them by straight lines.

• Materials

Purple rectangles
Materials are connected to the polygons to which they are applied by straight lines.

• Textures

Orange rectangles
Textures are connected to the materials that use them by straight lines.

• Palettes

Blue rectangles
Palettes are connected to the textures that use them by straight lines.

You can perform the following operations in schematic view:
• Scrolling through the view range.
• Enlarging or reducing the view range.
• Moving the view position of each object.
• Displaying everything in the center of the view.
• Displaying a selected object in the center of the view.
• Aligning all objects.
• Aligning below the selected object.

Hint: The positional relationships of each object in the schematic view will be saved in the imd file. 
These positional relationships will be maintained the next time you open the imd file.

6.2.2.1 Scrolling Through the View Range
Figure 6-3 - Schematic View Operation: Scrolling the View Range
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3D Material Editor
6.2.2.2 Enlarging and Reducing the View Range
To reduce the view range, while holding the Ctrl key down, drag with the center mouse button to the left 
from anywhere in the display range. The center of the reduced area will be where you started dragging. To 
enlarge the view range, while holding the Ctrl key down, drag with the center mouse button to the right 
from anywhere in the display range. The center of the enlarged area will be where you started dragging 
(Figure 6-4).

Figure 6-4 - Schematic View Operations: Reducing / Enlarging the View Range

Hint: If your mouse has a wheel, you can do these operations with the wheel. Rotating the wheel 
forward reduces; rotating it backward enlarges.
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The Object View
6.2.2.3 Moving the View Position of Each Object
To move the display position of an object and all the objects connected below it, use the left mouse button 
to drag a single object to the desired position (Figure 6-5).

Figure 6-5 - Schematic View Operations: Moving Objects 1

To move the display position of an object without moving the objects below it in the tree, hold down the 
Shift key and use the left mouse button to drag the object to the desired position (Figure 6-6).

Figure 6-6 - Schematic View Operations: Moving Objects 2
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3D Material Editor
By dragging with the left mouse button over the multiple selected object rectangles, the display positions of 
all the objects can be moved at the same time. (Figure 6-7).

Figure 6-7 - Schematic View Operations: Moving Objects 3
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The Object View
6.2.2.4 Displaying Everything in the Center of the View
This displays all of the objects in the center of the Object View. They will be reduced if they do not fit in the 
Viewing Range of the Object View (Figure 6-8). The positional relationships of the objects will not change.

Operating Procedure
1. Select “Schematic View” −> “View All in Center” in the “View” menu.

Figure 6-8 - Schematic View Operations: Viewing All in the Center of the View

There are two other ways to do this:

• When the keyboard focus is in the Object View, press the A key.

• Right-click and select “Display All in Center” in the pop-up menu that appears.
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3D Material Editor
6.2.2.5 Displaying the Selected Object in the View Center
This displays the selected object in the center of the Object View (Figure 6-9). Object positional 
relationships will not change.

Operating Procedure
1. Select “Schematic View” −> “Display Selected Object in Center” in the “View” menu.

Figure 6-9 - Schematic View Operations: Displaying the Selected Object in the Center of the View

There are two other ways to do this:

• When the keyboard focus is on the Object View, press the F key.

• Right-click and select “Display Selected Object in Center” in the pop-up menu that appears.
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The Object View
6.2.2.6 Aligning All Objects
This aligns the positions of all of the rectangles for each object. Textures and palettes that are not used by 
any material will be lined up under the rest of the objects (Figure 6-10). You can only use this when you 
have loaded an imd file.

Operating Procedure
1. Select “Schematic View” −> “Align All Objects” in the “View” menu.

Figure 6-10 - Schematic View Operations: Aligning All Objects

There are two other ways to do this:

• When the keyboard focus is in the Object View, press the Shift + R keys.

• Right-click and select “Align All Objects” in the pop-up menu that appears.
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6.2.2.7 Aligning from Selected Object Down
This aligns the positions of all of the objects connected below the selected object.

Operating Procedure
1. Select “Schematic View” −> “Align from Selected Object Down” in the “View” menu.

Figure 6-11 - Schematic View Operations: Aligning from Selected Object Down

There are two other ways to do this:

• When the keyboard focus is on the Object View, press the Shift + L keys.

• Right-click and select “Align from Selected Object Down” in the pop-up menu that appears.
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The Object View
6.2.3 Tree View
This mode displays the model’s hierarchical structure in Windows tree format. The objects are displayed 
as items on a tree made of icons and names (Figure 6-12).

Figure 6-12 - Object View: Tree View

The objects are displayed as follows:

• Graphics Scene

Displayed as the root of the tree.

• Model

Displayed as the root of the tree, in parallel with the Graphics Scene.

• Nodes

The root node is displayed as a child of the model. Other nodes are displayed as children of parent 
nodes.

• Polygons

Displayed as children of the node that includes them.

• Materials

Displayed as children of the polygons to which they are applied.

• Textures

Displayed as children of the model.

• Palettes

Displayed as children of the model.

Model (Selected Object)

Node

Polygon
Material

Texture
Palette

Graphics Scene
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6.2.4 Node List View
This mode gives a list view of nodes only (Figure 6-13). You will only be able to select nodes, because no 
other objects are displayed. For information on the characteristics of display list modes, and common 
operations, see "6.2.9 Display List Mode Characteristics" on page 48.

Figure 6-13 - Object View: Node List View

In addition to the node name, the following node properties are displayed as list items. For details on 
properties, see "7.5 Node Properties" on page 74.
• Index
• Node type
• Display flag
• Number of Processed Vertices
• Total number of polygons
• Number of triangular polygons
• Number of quadrilateral polygons

Selected Node
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6.2.5 Polygon List View
This mode gives a list view of polygons only (Figure 6-14). You will only be able to select polygons, 
because no other objects are displayed. For information on the characteristics of display list modes, and 
common operations, see "6.2.9 Display List Mode Characteristics" on page 48.

Figure 6-14 - Object View: Polygon List View

In addition to the polygon name, the following polygon properties are displayed as list items. For details on 
properties, see "7.6 Polygon Properties" on page 78.
• Index
• Number of Processed Vertices
• Total number of polygons
• Number of triangular polygons
• Number of quadrilateral polygons
• Normal Data Yes/No
• Vertex Color Data Yes/No
• Texture Coordinate Data Yes/No

Selected Polygon
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6.2.6 Material List View
This mode gives a list view of materials only (Figure 6-15). You will only be able to select materials, 
because no other objects are displayed. For information on the characteristics of display list modes and 
common operations, see "6.2.9 Display List Mode Characteristics" on page 48.

Figure 6-15 - Object View: Material List View

In addition to the material name, the following material property is displayed as a list item. For details on 
properties, see "7.7 Material Properties" on page 80.
• Index
• Polygon ID
• Polygon alpha
• Wireframe display flag
• Surface to display
• Polygon mode
• Fog flag
• Depth test condition flag
• Flag for updating depth buffer of translucent polygon
• Flag for drawing 1-dot polygon
• Flag for clipping at far plane
• Affected light
• Diffuse
• Ambient
• Specular
• Emission
• Flag for using specular reflection shininess table
• Mapped texture
• Texture coordinate transformation mode

Selected Material
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With the specific column items of material list display, the setting contents are shown in special notation as 
shown below.
• Affected light

The numbers for affected lights are shown as yellow icons ( ) and the numbers for non-

affected lights are shown as gray icons ( ).

• Diffuse, Ambient, Specular, Emission

The square that indicates the color is shown on the left, and the values for each component are shown 
in the order of RGB. For example, if the settings are R=31, G=16, and B=10, this would be shown as 

.
• Mapped texture

Along with the name of the mapped texture, the way the texture is repeated is shown on the right. With 
the way texture is repeated, clamp is shown as “C,” repeat is “R,” and flip is “F,” and they will be 
arranged in the order of S-T directions. For example, if clamp is set for the S direction, and repeat is 
set for the T direction, [CR] will be displayed on the right side of the texture name.

6.2.7 Texture List View
This mode gives a list view of textures only (Figure 6-16). You will only be able to select textures, because 
no other objects are displayed. For information on the characteristics of display list modes and common 
operations, see "6.2.9 Display List Mode Characteristics" on page 48.

Figure 6-16 - Object View: Texture List View

In addition to the texture name, the following texture properties are displayed as list items. For details on 
properties, see "7.8 Texture Properties" on page 89.
• Index
• Width
• Height
• Format
• Data Size
• Palette Color 0 Mode

Selected Texture
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6.2.8 Palette List View
This mode gives a list view of palettes only (Figure 6-17). You will only be able to select palettes, because 
no other objects are displayed. For information on the characteristics of display list modes, and common 
operations, see "6.2.9 Display List Mode Characteristics" on page 48.

Figure 6-17 - Object View: Palette List View

In addition to the palette name, the following palette properties are displayed as list items. For details on 
properties, see "7.9 Palette Properties" on page 91.
• Index
• Number of Colors
• Data Size

6.2.9 Display List Mode Characteristics
The display list mode differs from the schematic view and the tree view in that, in addition to the object 
name, various object information is displayed as list items.

This information is part of the object properties that are displayed in the Property View. For information on 
object properties, see "7 Properties" on page 53.

The object properties in the columns are there for the purpose of sorting and comparing property values in 
multiple same-type objects. The list does not display all of the object’s properties. Also, in the Object View, 
you cannot edit the properties that are displayed as column headings.

The following features and operations are common to the display list modes:
• Using color to differentiate by the number of characters in a name
• Rearrange the order of columns
• Adjust Column Width
• Sort by Column

6.2.9.1 Using Color to Differentiate by the Number of Characters in a Name
When imd files are used by the Nintendo NITRO System library, the names of the following must be no 
longer than 16 characters: node, polygon, material, texture, and palette.

In Display List Mode, when the number of characters in the name of any object exceeds 16 characters, the 
name will be displayed in red. (Figure 6-18)

Selected Palette
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Figure 6-18 - Using Color to Differentiate According to the Number of Characters in a Name

6.2.9.2 Rearrange the Order of Columns
By dragging each column item in the header line, the order of the columns can be rearranged (Figure 6-19).

Figure 6-19 - Rearranging the Order of Columns

Changed order of columns can be set back to the default settings.

 

© 2004-2005 Nintendo 49 NTR-06-0081-001-A8
Released: July 19, 2005



3D Material Editor
Operating Procedure
1. Select “Display List” −> “Reset the order of columns” in the “Display” menu.

This operation can be also done with the following method:

• From the popup menu that is displayed by right-clicking the mouse button, select “Reset the order of 
columns”.

6.2.9.3 Adjusting the Column Width
When you move the mouse pointer to one of the column border lines in the header row, the cursor 
changes. Then you can drag the mouse to the left or right to adjust column width (Figure 6-20).

Figure 6-20 - Adjusting Column Width

Changed column width can be set back to the default state.

Operating Procedure
1. Select “Display List” −> “Reset the column width” in the “Display” menu.

This operation can be also done with the following method:

• From the popup menu that is displayed by right-clicking the mouse button, select “Reset the column 
width”.
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6.2.9.4 Sorting by Column
If you click on one of the column headings in the header row, the list will be sorted according to the order in 
that column.

When arranged in ascending order, an upward triangle mark appears on the right side of the item name, 
and when arranged in descending order, a downward triangle mark appears on the right side of the item 
name (Figure 6-21).

Figure 6-21 - Sorting by Column
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7 Properties
This chapter describes the details of the properties that are displayed in the Property View. It also 
describes the contents that are displayed and how to modify them.

7.1 What Are Properties?
3D Material Editor calls the information, attributes, settings and the like that belong to an object by the 
generic name, object properties.

7.2 Property View
The Property View displays the properties of the object that is selected in the Object View.
In the Property View, it is possible to confirm, set, and edit the selected object’s properties.

The following property types can be displayed in the Property View. These correspond to each object.
• Graphics Scene properties
• Model properties
• Node properties
• Polygon properties
• Material properties
• Texture properties
• Palette properties

The selected object’s icon and name will be displayed at the top of the Property View. If an object is 
indexed, its index will appear to the right of its name.

When multiple objects are selected, the background changes to red, and the number of selected objects of 
the same type is displayed on the right (Figure 7-1). At this time, in the Property View, the properties will be 
displayed for the object that has been focused with the object view inside the selected object.

Figure 7-1 - Selected Object

You can switch the property view between hide and display.

If you hide the property view, the object view region will extend over the width of the window.

Operating Procedure
1. Select “Property View” in the “View” menu.

You can also use the following method:

• Press the button on the border between the object view and the property view. (Shortcut Key: F4)

 

 

When a single object is selected

When multiple objects are selected

The number of selected
objects of the same type.
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7.2.1 Editing Properties
Editing properties in the property view will cause the properties of the corresponding objects to change.

If multiple objects are selected, the corresponding properties for all objects of the same type that are 
selected will change. (Figure 7-2).

Figure 7-2 - Editing the Properties of Multiple Objects

Property View

Property A
Property B
Property C
...
...

Selected Objects

Material 1

Edit Property A

Property View

Property A for Materials 1, 2,
and 3 change at the same

time.

Property A
Property B
Property C
...
...

Material 3

Material 2
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7.3 Graphics Scene Properties
Graphics Scene properties are divided into the following types:
• Camera properties
• Light properties
• Toon / Highlight properties
• Alpha / Translucent properties
• Fog properties
• Edge Marking properties
• Rendering properties

You can use the tabs at the top of the Property View to switch the properties you set (Figure 7-3).
Property selected with the tabs will appear in the Property View.

Figure 7-3 - Graphics Scene Property Selection Tabs
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7.3.1 Camera
This is for setting camera, projection conversions, and depth buffering (Figure 7-4).

Figure 7-4 - Graphics Scene Properties: Camera

A. This sets camera position. It corresponds to the isd file <camera> element attribute position.

B. This sets the point the camera looks at. It corresponds to the isd file <camera> element attribute 
lookat.

C. This applies the camera position and the focal point position to NITRO-Viewer. This operation is 
only possible while communicating with NITRO-Viewer. For information on communications with 
NITRO-Viewer, see "9 Communications with NITRO-Viewer" on page 121.

D. This acquires the camera position and the focal point position from NITRO-Viewer. This operation 
is only possible while communicating with NITRO-Viewer. For information on communications with 
NITRO-Viewer, see "9 Communications with NITRO-Viewer" on page 121.

E. This selects from the following two types of projection transformation:
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• Perspective projection
• Orthogonal projection

It corresponds to the isd file <camera> element attribute projection.

F. This sets the field of view (fovy) for perspective projection. It corresponds to the isd file <camera> 
element attribute perspective_fovy.

G. This sets the aspect ratio (aspect) for perspective projection. It corresponds to the isd file 
<camera> element attribute perspective_aspect.

H. The sets the projection width for orthogonal projection. It corresponds to the isd file <camera> 
element attribute ortho_width.

I. This sets the projection height for orthogonal projection. It corresponds to the isd file <camera> 
element attribute ortho_height.

J. This sets the value for the near clip plane. It corresponds to the isd file <camera> element 
attribute near.

K. This sets the value for the far clip plane. It corresponds to the isd file <camera> element attribute 
far.

L. Selects from the following depth buffering methods:
• Z Buffering
• W Buffering

It corresponds to the isd file <camera> element attribute depth_buffer.

M. Sets the ScaleW value that is applied to the projection matrix.

It corresponds to the isd file <camera> elements attribute scale_w.

Note: When the depth buffering method is set to Z buffering, depending on the distance from the 
camera, when the ScaleW value is large, this may not be able to create an appropriate 
projection matrix, and the view on NITRO-Viewer may be corrupted. 
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7.3.2 Light
This is for settings related to lights and spectral reflection brightness tables (Figure 7-5).

Figure 7-5 - Graphics Scene Properties: Light

A. Selects the light you want to set. You can choose from light 0 – light 3. When you change your 
selection, direction (B in the figure) and color (F in the figure) will change to the values for the 
selected light.

B. This sets the selected light’s directional vector. The setting range is -1.0 – 1.0 for each of the X, Y, 
and Z components. It corresponds to the isd file <light0 – 3> element attribute direction.

C. This normalizes (sets the vector length to 1) the selected light’s directional vector.

D. The directional vector of the selected light is applied to NITRO-Viewer. This operation is only 
possible while communicating with NITRO-Viewer For information on communications with 
NITRO-Viewer, see "9 Communications with NITRO-Viewer" on page 121.

E. The directional vector of the selected light is acquired from NITRO-Viewer. This operation is only 
possible while communicating with NITRO-Viewer. For information on communications with 
NITRO-Viewer, see "9 Communications with NITRO-Viewer" on page 121.

F. This sets the selected light’s color. If you click the Color button, you will be able to set a color from 
the color picker. For details on the color picker, see "7.10 Changing RGB Values with the Color 
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Picker" on page 92. This corresponds to the isd file <light0 – 3> element attribute color.

G. Press the button to display the specular reflection shininess setting table. For details on the dialog 
box, see "7.3.8 Specular Reflection Shininess Table / Fog Density Table Setting Dialog Boxes" on 
page 64.

H. Displays a graph of the current setting of the specular reflection shininess table. The horizontal axis 
indicates the specular reflection shininess number, and the vertical axis indicates the value of the 
specular reflection shininess. It corresponds to the isd file <shininess_table> element’s contents.

7.3.3 Toon / Highlight
Figure 7-6 - Graphics Scene Properties: Toon / Highlight

A. When you are performing toon / highlight shading, you can select from the following two shading 
types:
• Toon shading
• Highlight shading

This corresponds to the isd file <toon_highlight> element attribute mode.

B. Press the button to display the toon table setting dialog box. For details on the dialog box, see 
"7.3.9 Toon Table / Edge Color Setting Dialog Box" on page 66.

C. Displays the current setting of the toon table. Color 0 to Color 31 are arranged from left to right. 
This corresponds to the isd file <toon_table> element’s contents.
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7.3.4 Alpha/Translucency
This makes settings related to alpha processing and translucency processing (Figure 7-7).

Figure 7-7 - Graphics Scene Properties: Alpha/Translucency

A. This selects whether to enable alpha test. It corresponds to the isd file <alpha_test> element 
attribute enable.

B. This sets a reference value for the alpha test. You can only make this setting if you are doing an 
alpha test. This corresponds to the isd file <alpha_test> element attribute reference.

C. This selects whether to do alpha-blending.

This corresponds to the isd file <alpha_blending> element attribute enable.

D. Selects a translucent Y polygon sorting mode from the 2 following types.
• Auto Sort Mode
• Manual Sort Mode

This corresponds to the isd file <y_sorting> element attribute mode.
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7.3.5 Fog
This makes settings related to fog and fog density tables (Figure 7-8).

Figure 7-8 - Graphics Scene Properties: Fog

A. This sets fog color. If you click the color button, you will be able to set colors from the color picker. 
For details on the color picker, see "7.10 Changing RGB Values with the Color Picker" on page 92. 
This corresponds to the isd file <fog> element attribute color.

B. This sets the fog alpha value. It corresponds to the isd file <fog> element attribute alpha.

C. This sets the shift value that is used in the calculation to determine fog density. It corresponds to 
the isd file <fog> element attribute shift.

D. This sets the offset value that is used in the calculation to determine fog density. It corresponds to 
the isd file <fog> element attribute offset.
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E. You can select from the following fog modes:
• Apply fog to the pixel color and the pixel alpha value
• Only apply fog to the pixel alpha value

This corresponds to the isd file <fog> element attribute mode.

F. Press the button to display the fog density setting dialog box. For details on the dialog box, see 
"7.3.9 Toon Table / Edge Color Setting Dialog Box" on page 66.

G. Displays a graph of the current setting of the fog density table. The horizontal axis represents the 
fog density number and the vertical axis represents the fog density value. It corresponds to the isd 
file <fog_table> element’s contents.

7.3.6 Edge Marking
This makes settings related to edge marking (Figure 7-9).

Figure 7-9 - Graphics Scene Properties: Edge Marking

A. This selects whether to do edge marking. It corresponds to the isd file <edge_marking> element 
attribute enable.

B. Press the button to display the edge color setting dialog box. For details on the dialog box, see 
"7.3.9 Toon Table / Edge Color Setting Dialog Box" on page 66.

C. Displays the current setting of edge color. Color 0 to Color 7 are arranged from left to right. This 
corresponds to the isd file <edge_color> element’s contents.

7.3.7 Rendering
This makes settings related to rendering (Figure 7-10).
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Figure 7-10 - Graphics Scene Properties: Rendering Buffer

A. This selects whether to do antialiasing.

It corresponds to the isd file element <antialias> attribute enable.

B. This sets the depth value for the one-dot polygon viewing boundary.

It corresponds to the isd file element <render_1_pixel_depth> attribute w.

C. This sets the color used for color buffer clearing. If you click the color button, you will be able to set 
colors from the color picker. For details on the color picker, see "7.10 Changing RGB Values with 
the Color Picker" on page 92. This corresponds to the isd file <clear_color> element attribute 
color.

D. This sets the alpha value used for color buffer clearing. It corresponds to the isd file 
<clear_color> element attribute alpha.

E. This sets the polygon ID used for attribute buffer clearing. It corresponds to the isd file 
<clear_color> element attribute polygon_id.

F. This sets the fog enable flag used for attribute buffer clearing. It corresponds to the isd file 
<clear_color> element attribute fog_enable.
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G. This sets the depth value used for depth buffer clearing. It corresponds to the isd file 
<clear_color> element attribute depth.

7.3.8 Specular Reflection Shininess Table / Fog Density Table Setting Dialog 
Boxes

With the specular reflection shininess table / fog density table setting dialog boxes, detailed settings can be 
made for the specular reflection shininess table and the fog density table.

Between the specular reflection shininess table setting and the fog density table settings, there are 
difference as shown in the table below (Table 7-1). However, how to use the dialog box and how to use the 
table are the same. (In the explanation in this chapter, the specular reflection shininess table setting is 
used as an example.)

Table  7-1 - Differences Between Specular Reflection Shininess Table / Fog Density Table 
Setting Dialog Boxes

Figure 7-11 - Specular Reflection Shininess Table / Fog Density Table Setting Dialog Box

Table Number of values to be set 
(horizontal axis)

Setting range of each value 
(vertical axis)

Specular reflection shininess table Shininess 0 to 127, 128 values 0 to 255, 256 steps

Fog density table Density 0 to 31, 32 values 0 to 127, 128 steps
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A. A list of each value in the table.

The values for the control points in graph B are indicated with dots. (Control point is described 
later.) When a value is selected, a rectangular mark is displayed at a corresponding location in 
graph B. By selecting a value and pressing Enter, a value can be input directly. When the value is 
input directly, the location of the control point in graph B is recalculated.

B. Displays a graph of the current table settings.

The horizontal axis of the graph represents the number in the table, and the vertical axis 
represents the value. Round symbols in the graph are the control point for handling the graph. 
Control points are created automatically by determining the difference in the angle. In the graph, 
control points can be added, moved or deleted to change the setting in the table. Each value in the 
table is set as a value that was calculated by linear interpolating neighboring control points.

Control points are edited with the following operation. (Table 7-2)

Table  7-2 - Specular Reflection Shininess Table / Fog Density Table Setting Dialog Box

At the bottom left of the graph, the number and value that correspond to the location of the cursor 
in the graph are displayed.

At the bottom right of the graph, the number and value of the selected control point are displayed.

By pressing the buttons at the top of the graph, the following operations can be performed. (Table 7-3).
Table  7-3 - Toolbar Buttons

Edit Operation

Adding control point
Left-click the mouse in the graph area.

Control point cannot be added if the number that correspond to the 
cursor location already became a control point.

Moving control point
Move the cursor to the control point and left-drag the mouse.

Control point can be moved within the range of the left and right neigh-
boring control points.

Deleting control point
Move the cursor to the control point and right-click the mouse.

Control point cannot be deleted if there is only one point.

Button Description

Changes the setting back to the original state. (Undo)

Number of undo actions are not limited.

Reapplies the change that was set back with Undo.

Number of redo actions are not limited.

Deletes the selected control point.

Flips the graph horizontally.
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C. Returns the table setting to the state when the dialog box was opened.

7.3.9 Toon Table / Edge Color Setting Dialog Box
Toon table setting dialog box / edge color setting dialog box allow detailed settings for toon table and edge 
color.

There are some differences between the toon table settings and the edge color settings, as shown in the 
table below (Table 7-4). How to use dialog boxes and how to set tables are the same. (The toon table 
setting dialog box is used as an example in this chapter.)
Table  7-4 - Differences Between Toon Table / Edge Color Setting Dialog Boxes

Flips the graph vertically.

Applies the preset setting 1.

Applies the preset setting 2.

Applies the preset setting 3.

Applies the preset setting 4.

Table Number of colors to be set

Toon table Color 0 - 31, 32 colors

Edge color Color 0 - 7, 8 colors

Button Description
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Figure 7-12 - Toon Table / Edge Color Setting Dialog Box

A. List of each color in the table. Select the color you want to change (multiple colors can be 
selected). The number of selected colors are displayed at the bottom of the list. There are several 
ways to select colors. (Table 7-5)

Table  7-5 - Operation For Selecting Colors

The following operations can be performed by pressing each of the buttons on the upper part of 
the list. (Table 7-6)

Table  7-6 - Toolbar Buttons

Procedure Operation

Left-clicking the mouse Selects a color.

Ctrl + left-clicking the mouse
(or right-clicking the mouse)

Selects multiple colors.

Or, deselects selected color(s).

Shift + left-clicking the mouse
(or dragging the mouse to the left or right)

Selects multiple colors in a series.

Button Description

Selects all colors.

Copies the selected color.

When multiple colors are selected, the same number of copies are made as 
the number of colors being selected.

A B

C
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B. The region that changes the selected color.

The color change is applied to the selected colors. For details on how to change colors, see "7.10 
Changing RGB Values with the Color Picker" on page 92.

C. Sets the table setting back to the state when the dialog box was opened.

Pastes the copied color to the selected color. When multiple colors are 
selected,  a series of copies starting from the color that is selected at the 
top is pasted in a downward direction.

Sets the changed setting back to the original state. (Undo) 

Number of undo actions are not limited.

Reapplies the change that was set back. (Redo)

Number of redo actions are not limited.

Moves the selected color up by one line.

When multiple colors are selected, they move at once.

Moves the selected color down by one line.

When multiple colors are selected, they move at once.

Changes two colors that are selected, and creates gradation by using linear 
interpolation. This operation can be performed only when selected colors 
are not next to each other.

Exchanges two selected colors.

This operation can be performed only when two colors are selected.

Button Description
NTR-06-0081-001-A8 68 © 2004-2005 Nintendo
Released: July 19, 2005



Model Properties
7.4 Model Properties
There are four types of model properties.

• [General] Properties

• [Data Size] Properties

• [Rendering Priority] Properties

• [File Information] Properties

You can use the tabs on the top of the property view to select which of the properties you want to set. 
(Figure 7-13)

Figure 7-13 - Model Property Selection Tabs

7.4.1 General
This displays detailed model information (Figure 7-14).
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Figure 7-14 - Model Properties: General

A. This is the shift value that is applied to vertex position coordinates when drawing. It corresponds to 
the imd file <model_info> element attribute pos_scale.

B. This is the scaling calculation method. Currently it is one of following:
• Standard
• Maya method
• Softimage method

This corresponds to the imd file <model_info> element attribute scaling_rule.
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C. This is the method of outputting vertex position coordinates and vertex color. You can use one of 
the following:
• Direct method
• Index method

This corresponds to the imd file <model_info> element attribute vertex_style.

D. This is the scale factor that is applied to the entire model when outputting an imd file from a 3DCG 
tool. It corresponds to the imd file <model_info> element attribute magnify.

E. This is the StartFrame that is specified when outputting an imd file from a 3DCG tool. It 
corresponds to the imd file <model_info> element attribute tool_start_frame.

F. This is the texture matrix calculation method. Currently it will be one of the following:
• Maya method
• SOFTIMAGE|3D method
• SOFTIMAGE|XSL method
• 3ds max method

This corresponds to the imd file <model_info> element attribute tex_matrix_mode.

G. This is the compression status of the nodes that are output. It will be one of the following:
• None
• Cull
• Merge
• Unite
• Unite-Combine

This corresponds to the imd file <model_info> element attribute compress_node.

H. The number of nodes when compressing and when not compressing.

If there is no node compression, only the number of nodes when not compressed will be shown. 
This corresponds to the imd file <model_info> element attribute node_size.

I. This indicates whether the material has been compressed. This corresponds to the imd file 
<model_info> element attribute compress_material.

J. The number of nodes when compressing and when not compressing.

If there is no material compression, only the number of nodes when not compressed will be 
shown. This corresponds to the imd file <model_info> element attribute material_size.

K. This is the method of outputting texture data when outputting an imd file from a 3DCG tool. It will 
be one of the following:
• Only the textures that are used
• All textures

This corresponds to the imd file <model_info> element attribute output_texture.

L. This indicates whether you are using a polygon strip. It corresponds to the imd file <model_info> 
element attribute use_primitive_strip.

M. When outputting an imd file from a 3DCG tool, this indicates whether vertices that were set as 
weighted envelope were forced to full weighted envelope on output. It corresponds to the imd file 
<model_info> element attribute force_full_weight.

N. This is the total number of processed vertices in polygons that are contained in a model. It 
corresponds to the imd file <output_info> element attribute vertex_size.

O. This is the total number of polygons that are contained in a model. This corresponds to the imd file 
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<output_info> element attribute polygon_size.

P. This is the number of triangular polygons contained in a model.

It corresponds to the imd file <output_info> element attribute triangle_size.

Q. This is the number of quadrilateral polygons contained in a model.

It corresponds to the imd file <output_info> element attribute quad_size.

7.4.2 Data Size
This shows information on the data size of each type of data contained in a model. (Figure 7-15)

Figure 7-15 - Model Properties: Data Size

A. This is the total data size of the textures currently used by any material.

When this size is equal to the total texture data size contained in the model, (B in the figure) it is 
displayed in blue. If it is less, it is displayed in red.

B. This is the total data size of all of the textures that are contained in the model.

C. This is the total data size of palettes used by any material.

When this size is equal to the total palette data size contained in the model, (D in the figure) it is 
displayed in blue. If it is less, it is displayed in red.

D. This is the total data size of the palettes contained a model.

7.4.3 Rendering Priority
This shows information on the rendering priority information for all polygons in a model. (Figure 7-16)

Figure 7-16 - Model Properties: Rendering Priority
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List rows display the names of materials (applied to polygons), polygons, and nodes (to which polygons 
belong). Rendering priority values are ordered in ascending order.

For details on rendering priority values and how rendering priority is handled by NITRO-Viewer, see 
manuals for NITRO Intermediate File Format, NITRO-System libraries, and NITRO Intermediate File 
Output plug-ins.

Note: 3D Material Editor cannot change rendering priority values.

Hint: When you select any of the list rows, the polygons that correspond to those on NITRO-Viewer 
will blink.

7.4.4 File Information
This displays information related to the open imd file. (Figure 7-17)

Figure 7-17 - Model Properties: File Information

A. Sets a comment for a file.

You can use both half-width and full-width characters. There is no limit on the number of characters.

This corresponds to the content of the imd file <comment> element.

B. This is the user name of the person who created the imd file.

It corresponds to the imd file <original_create> element attribute user.

C. This is the name of the machine on which the imd file was created.

It corresponds to the imd file <original_create> element attribute host.
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D. This is the date and time that the imd file was created.

It corresponds to the imd file <original_create> element attribute date.

E. This is name of the 3DCG tool plug-in that was used to export the imd file.

It corresponds to the imd file <original_generator> element attribute name.

F. This is the version of the 3DCG tool plug-in that was used to export the imd file.

It corresponds to the imd file <original_generator> element attribute version.

G. This is the name of the scene in the 3DCG tool that was the source of the imd file export.

It corresponds to the imd file <original_create> element attribute source.

H. The file size at the time the imd file was first loaded.

I. The file size at the time the imd file was saved at the end.

Because 3D Material Editor adds special extension elements to the imd file to be saved, even 
when the file is saved without changing contents, the file size may become larger when the file is 
loaded.

Regarding the extension elements that are added to imd files, see ì5.2.4 3D Material Editor Local 
Extension Elements.

J. Binary file size after the binary conversion when transferred to NITRO-Viewer at the end.

7.5 Node Properties
Node properties are divided into the following categories.

• [General] Properties

• [Rendering Priority] Properties

You can use the tabs at the top of the Property View to switch the properties you set  (Figure 7-18)

Properties selected with the tabs will appear in the Property View.

Figure 7-18 - Node Property Selection Tabs

7.5.1 General
This displays general node information (Figure 7-19).
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Figure 7-19 - Node Properties: General
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A. This is the node type. It will be one of the following:
• Null
• Mesh
• Joint
• Chain
• Effector

This corresponds to the imd file <node> element attribute kind.

B. This is the billboard display setting. It will be one of the following:
• Off
• On
• Y axis only

This corresponds to the imd file <node> element attribute billboard.

C. This is a flag for scaling calculations that Maya can set. This is enabled only when the model scale 
calculation method is set to "Maya method." This corresponds to the imd file <node> element 
attribute scale_compensate.

D. This indicates whether the node’s matrix is being used to draw polygons. It corresponds to the imd 
file <node> element attribute draw_mtx.

E. This selects whether to display this node. It corresponds to the imd file <node> element attribute 
visibility.

F. This is the node Scale value. It corresponds to the imd file <node> element attribute scale.

G. This is the node Rotate value. It corresponds to the imd file <node> element attribute rotate.

H. This is the node Translate value. It corresponds to the imd file <node> element attribute 
translate.

I. This is the total number of processed vertices for all of the polygons that belong to this node. It 
corresponds to the imd file <node> element attribute vertex_size.

J. This is the total number of polygons that belong to this node. This corresponds to the imd file 
<node> element attribute polygon_size.

K. This is the total number of triangular polygons that belong to this node.

It corresponds to the imd file <node> element attribute triangle_size.

L. This is the total number of quadrilateral polygons that belong to this node.

It corresponds to the imd file <node> element attribute quad_size.

M. This is the minimum coordinate value of the grid that circumscribes all of the polygons that belong 
to this node. It corresponds to the imd file <node> element attribute volume_min.

N. This is the maximum coordinate value of the grid that circumscribes all of the polygons that belong 
to this node. It corresponds to the imd file <node> element attribute volume_max.

O. This is the radius of the sphere that circumscribes all of the polygons that belong to this node. It 
corresponds to the imd file <node> element attribute volume_r.
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7.5.2 Rendering Priority
Rendering priority information for all polygons that belong to a node is listed here. (Figure 7-20)

Figure 7-20 - Node Properties: Rendering Priority

List rows display the names of materials (applied to polygons), polygons, and nodes (to which polygons 
belong). Rendering priority is ordered in ascending order.

For details on rendering priority values and how rendering priority is handled by NITRO-Viewer, see 
manuals for NITRO Intermediate File Format, NITRO-System libraries, and NITRO Intermediate File 
Output plug-ins.

Note: 3D Material Editor cannot change rendering priority values.

Hint: When you select any of the list rows, the polygons that correspond to those on NITRO-Viewer 
will blink.
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7.6 Polygon Properties
This displays detailed polygon information (Figure 7-21).

Figure 7-21 - Polygon Properties

A. This is the number of processed polygon vertices. It corresponds to the imd file <polygon> 
element attribute vertex_size.

B. This is the total number of polygons. It corresponds to the imd file <polygon> element attribute 
polygon_size.

C. This is the total number of triangular polygons. It corresponds to the imd file <polygon> element 
attribute triangle_size.

D. This is the total number of quadrilateral polygons. It corresponds to the imd file <polygon> 
element attribute quad_size.

E. This is the minimum coordinate value of the grid that circumscribes this polygon. It corresponds to 
the imd file <polygon> element attribute volume_min.

F. This is the maximum coordinate value of the grid that circumscribes this polygon. It corresponds to 
the imd file <polygon> element attribute volume_max.

G. This is the radius of the sphere that circumscribes this polygon. It corresponds to the imd file 
<polygon> element attribute volume_r.
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H. This indicates whether there is normal data in the polygon. It corresponds to the imd file 
<polygon> element attribute nrm_flag.

I. This indicates whether there is vertex color data in the polygon. It corresponds to the imd file 
<polygon> element attribute clr_flag.

J. This indicates whether there is texture coordinate data in the polygon. It corresponds to the imd file 
<polygon> element attribute tex_flag.
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7.7 Material Properties
Material properties are divided into the following four property types:
• “Attribute” properties
• “Color” properties
• “Texture” properties
• “Texture coordinate transformation” properties

You can use the tabs on the top of the Property View to switch the properties you want to set (Figure 7-22). 
The property selected from the tabs will be displayed in the Property View.

Figure 7-22 - Material Property Selection Tabs

7.7.1 Attributes
This sets material attribute values (Figure 7-23).

Figure 7-23 - Material Properties: Attributes

A

G

F

ED

C

B

I

H

J

NTR-06-0081-001-A8 80 © 2004-2005 Nintendo
Released: July 19, 2005



Material Properties
A. This sets the polygon ID. The upper three bits of the polygon ID are also used as the edge color 
number when edge marking is used. Therefore, the edge color number (0 – 7) that corresponds to 
the polygon ID value is displayed at the bottom. This corresponds to the imd file <material> 
element attribute polygon_id.

B. This selects whether to display as a wireframe. It corresponds to the imd file <material> 
element attribute wire_mode.

C. This sets the polygon alpha value. You can only set this when wireframe is not displayed. It 
corresponds to the imd file <material> element attribute alpha.

D. You can select from the following polygon surfaces:
• Front face
• Back face
• Both faces

This corresponds to the imd file <material> element attribute face.

E. You can select from the following four polygon draw modes:
• Modulation mode
• Decal mode
• Toon / Highlight shading
• Shadow polygon

This corresponds to the imd file <material> element attribute polygon_mode.

F. This selects whether to enable fog. It corresponds to the imd file <material> element attribute 
fog_flag.

G. This selects depth buffer update conditions. It corresponds to the imd file <material> element 
attribute depth_test_decal.

H. This selects whether to update the depth buffer when rendering translucent polygons. It 
corresponds to the imd file <material> element attribute translucent_update_depth.

I. This selects whether to render 1-dot polygons. It corresponds to the imd file <material> element 
attribute render_1_pixel.

J. This selects whether to clip a polygon when it intersects the far plane. It corresponds to the imd file 
<material> element attribute far_clipping.
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7.7.2 Color
This sets calculations for material color and light (Figure 7-24).

Figure 7-24 - Material Properties: Color

A. This selects the lights that will be used when the light calculations are performed. You can specify 
any combination of the lights 0 – 3. This corresponds to the imd file <material> element 
attributes light0, light1, light2, light3.

B. This sets the material’s diffuse color. If you click the color button, you can set colors from the color 
picker. For details on the color picker, see "7.10 Changing RGB Values with the Color Picker" on 
page 92. This corresponds to the imd file <material> element attribute diffuse.

C. This sets the material’s ambient color. If you click the color button, you can set colors from the 
color picker. For details on the color picker, see "7.10 Changing RGB Values with the Color Picker" 
on page 92. This corresponds to the imd file <material> element attribute ambient.

D. This sets the material’s specular color. If you click the color button, you can set colors from the 
color picker. For details on the color picker, see "7.10 Changing RGB Values with the Color Picker" 
on page 92. This corresponds to the imd file <material> element attribute specular.

E. This sets the material’s emission color. If you click the color button, you can set colors from the 
color picker. For details on the color picker, see "7.10 Changing RGB Values with the Color Picker" 
on page 92. This corresponds to the imd file <material> element attribute emission.

F. This selects whether to use a specular reflection table when calculating the specular component. It 
corresponds to the imd file <material> element attribute shininess_table_flag.

A

F

E

D

C

B

NTR-06-0081-001-A8 82 © 2004-2005 Nintendo
Released: July 19, 2005



Material Properties
7.7.3 Texture
This sets a texture to map onto polygons (Figure 7-25). You can set this property only if there are textures 
in the model.

Figure 7-25 - Material Properties: Texture

A. This selects whether to map a texture onto polygons.

B. This selects the texture to map onto the polygons from the textures that are registered in the 
model. It corresponds to the imd file <material> element attribute 
tex_image_idx,tex_palette_idx.

C. The displays detailed information for the currently selected texture. For detailed information on 
textures, see "7.8 Texture Properties" on page 89.

D. This selects texture S, T direction repeats from the following types:
• Clamp
• Repeat
• Mirror

This corresponds to the imd file <material> element attribute tex_tiling.
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7.7.4 Texture Coordinate Transformation
This makes settings related to texture coordinate transformation (Figure 7-26). You can only set this 
property if a texture is mapped.

Figure 7-26 - Material Properties: Texture Coordinate Transformation

A. This selects the texture coordinate transformation method from the following four types:
• No texture coordinate transformation
• Input source: Vertex texture coordinates
• Input source: Normal vectors
• Input source: Vertex coordinates

You can only select “Input source: Vertex texture coordinates” if there are vertex texture 
coordinates in the corresponding polygons. If set to “Input source: Normal Vectors” or “Input 
source: Vertex Coordinates”, the settings cannot be changed. This corresponds to the imd file 
<material> element attribute tex_gen_mode.

B. This sets the Scale value configured in the texture matrix. It corresponds to the imd file 
<material> element attribute tex_scale.
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C. This sets the Rotate value configured in the the texture matrix. It corresponds to the imd file 
<material> element attribute tex_rotate.

D. This sets the Translate value configured in the texture matrix. It corresponds to the imd file 
<material> element attribute tex_translate.

E. By entering a check, the S and T components of the Scale can be changed at the same time.

F. This resets the Scale, Rotate, and Translate settings.

G. When the texture coordinate conversion mode is either “Input Source: Normal Vector” or “Input 
Source: Vertex Coordinate”, this indicates whether or not there is a vertex texture coordinate 
command in the corresponding polygon. This corresponds to the imd file <material> element 
attribute tex_gen_st_src.

H. This configures the texture effect matrix when using the texture environment mapping or projection 
mapping. This corresponds to each row component in order from the top and each column 
component in order from the left. This corresponds to the imd file <material> element attribute 
tex_effect_mtx.

I. This configures the texture effect matrix to a unit matrix.

J. This displays a dialog box used to configure the texture effect matrix for environment mapping. It is 
only valid when the texture coordinate conversion mode is “Input Source: Normal Vector”. For 
further details about this dialog box, refer to "7.7.5 The Environment Mapping Configuration Dialog 
Box" on page 85.

K. This displays a dialog box used to configure the texture effect matrix for projection mapping. It is 
only valid when the texture coordinate conversion mode is “Input Source: Vector Coordinate”. For 
further details about this dialog box, refer to "7.7.5 The Environment Mapping Configuration Dialog 
Box" on page 85.

Caution: In order to perform environment and projection mapping for a texture, the texture coordinate 
conversion mode for the relevant materials must each be set in advance to either “Input 
Source: Normal Vector” or “Input Source: Vertex Coordinate” via the output of an imd file 
from one of the 3D CG tools. (For further details, refer to the manual each for 3D CG tool as 
used on NITRO).

It is impossible to switch to “Input Source: Normal Vector” or “Input Source: Vertex Coordi-
nate” from another texture conversion mode in the 3D material editor.

Caution: The texture effect matrix is a 4x4 matrix in an imd file, but since the 3rd and 4th columns 
have no influence on the texture coordinate conversion, only the 4x2 components in the 1st 
and 2nd column can be set with the 3D material editor. 

Caution: When the texture coordinate conversion mode is either “Input Source: Normal Vector” or 
“Input Source: Vertex Coordinate”, the settings below will not be used.

[Input Source: Normal Vector] Translate value and the 4th row component of the texture 
effect matrix 

[Input Source: Vertex Coordinate] Scale value, Rotate value, and Translate value

7.7.5 The Environment Mapping Configuration Dialog Box
The environment mapping configuration dialog box can be used to perform simple configurations in order 
to make the texture effect matrix usable for environment mapping. (Figure 7-27)
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Figure 7-27 - Material Properties: Environment Mapping Configuration

A. Configures the texture mapping angle (in degrees) for the camera line-of-sight. 

The horizontal axis on the configuration screen shows the degrees in the horizontal direction, 
while the vertical axis shows the degrees in the vertical direction.

By optionally clicking or dragging a region, the corresponding degrees will display on graph B. 

B. This section allows for the direct input of the horizontal and vertical mapping degrees.

7.7.6 The Projection Mapping Configuration Dialog Box
The projection mapping configuration dialog box can be used to perform simple configurations in order to 
make the texture effect matrix usable for projection mapping.(Figure 7-28)
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Figure 7-28 - Material Properties: Projection Mapping Configuration

A. Configures a virtual target position used to determine the direction in which the texture will be 
projected. 

The texture is projected centered on the direction that passes through this position. 

B. This configures the texture projection angle (in degrees) for the coordinate-system Z axis direction. 

The horizontal axis on the configuration screen shows the degrees in the horizontal direction, 
while the vertical axis shows the degrees in the vertical direction. 

By optionally clicking or dragging a region, the corresponding degrees will display on graph C. 

C. This section allows for the direct input of the horizontal and vertical projection mapping degrees. 

D. This configures the projection size (width and height) of the texture.

E. By putting a check here, the height and width of the projection size can be changed at the same 
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time.

Hint: When communicating with NITRO-Viewer, while the dialog box is being displayed, an addi-
tional line displays on the NITRO-Viewer screen that shows the current projection direction 
and projection size of the projection mapping. The size of this additional line depends on the 
size of the coordinate system. For further details, refer to the NITRO-Viewer manual.

The schematic meanings of each item that can be set with the projection mapping configuration dialog box 
are as follows (Figure 7-29).

(The figure is the actual screen as displayed in NITRO-Viewer.)

Figure 7-29 - A Projectionally Mapped Model

Position set with A
The degrees set with B are centered here

Size set with  DProjectionally mapped model
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7.8 Texture Properties
This displays detailed texture information (Figure 7-30).

Figure 7-30 - Texture Properties

A. This is the texture’s color image.

B. This is the texture’s alpha image. It displays the texture’s transparency level in grayscale (opaque 
regions are white, transparent regions are black).

C. This is the texture’s image size (width x height). It corresponds to the imd file <tex_image> 
element attributes width, height.
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D. This is the texture format. It will be one of the following:
• 4-color palette texture
• 16-color palette texture
• 256-color palette texture
• A5I3 translucent texture
• A3I5 translucent texture
• 4x4 texel compressed texture
• Direct color texture

It corresponds to the imd file <tex_image> element attribute format.

E. In the case of a color index format, this determines how palette color 0 is handled. It will be one of 
the following:
• Use as a color
• Use as a transparent color

In the case of a format that does not use color indexing (4x4 texel compressed data, direct color 
texture data), nothing will be displayed. This corresponds to the imd file <tex_image> element 
attribute color0_mode.

F. This is the palette name that will be used for a color index type format. In the case of a format that 
does not use color indexing (4x4 texel compressed data, direct color texture data), nothing will be 
displayed. This corresponds to the imd file <tex_image> element attribute palette_name.

G. This is the texture’s data size. It displays the texture’s data size in kilobytes (KB) and bytes. In the 
case of 4x4 texel compressed textures, the palette index data size is included.

H. This is the image size of the texture image file (width x height). It corresponds to the imd file 
<tex_image> element attribute original_width,original_height.

I. This is the path to the texture image file on the computer. If the path character string is longer than 
the width of the edit box, you can display it by scrolling in the edit box. This corresponds to the imd 
file <tex_image> element attribute path.
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7.9 Palette Properties
This displays palette information details (Figure 7-31).

Figure 7-31 - Palette Properties

A. This is the palette’s color image. The colors in the palette are ordered from the top left to the 
bottom right.

B. This is the number of colors in the palette. It corresponds to the imd file <tex_palette> element 
attribute color_size.

C. This is the palette’s data size. It displays the palette’s data size in kilobytes (KB) and bytes.
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7.10 Changing RGB Values with the Color Picker
You can use the color picker to set RGB values for properties in which RGB values are set. With the color 
picker you can visually select RGB values (Figure 7-32).

Figure 7-32 - Color Picker

A. This displays the current color.

B. If you click this button, the current color will be registered as the color in the selection frame in the 
color list (C in the figure). Up to 16 colors can be registered in the color list.

C. This is the registered color list. Left-clicking a color region will change the current color. Right-
clicking a color region will switch the position of the selection frame.

D. Press the button to set the color that is registered in the color list to the initial setting. (When 
executing it, the confirmation dialog box will appear.

E. This is the hue change bar. If you change the hue, the current color will change.

F. This is the saturation, value change plane. This color plane corresponds to the current hue set by 
the hue change bar (E in the figure). If you click any region the current color will change.
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G. This sets the R values in the range of 0 – 31. It works in conjunction with the bar on the right (J in 
the figure).

H. This sets the G values in the range of 0 – 31. It works in conjunction with the bar on the right (K in 
the figure).

I. This sets the B values in the range of 0 – 31. It works in conjunction with the bar on the right (L in 
the figure).

J. This is the R value change bar. At the left edge R=0, and at the right edge R=31. The bar’s 
background shows how a change in the R value will change the color.

K. This is the G value change bar. At the left edge G=0, and at the right edge G=31. The bar’s 
background shows how a change in the G value will change the color.

L. This is the B value change bar. At the left edge B=0, and at the right edge B=31. The bar’s 
background shows how a change in the B value will change the color.

M. If you click this button, the current color will be reset to the color before the change. 
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7.11 Copying/Pasting Material Settings
You can copy the content that you change in Material Properties. You can paste the copied material 
settings into another material to give it the same settings.

These are the material setting copy/paste operations:
• Copy settings
• Paste all of the settings
• Paste special...

7.11.1 Copying Settings
This copies all of the settings for the selected material.

If multiple materials are selected, the settings cannot be copied.

Operating Procedure
1. In the Object View, select the material whose settings you want to copy.

2. Select “Copy Settings” on the “Object” menu. 
(Toolbar button: , Shortcut Keys: Ctrl + Shift + C)

You can also use the following method:

• Select a material in the Object View. Right-click with the mouse and select “Copy Settings” from the 
pop-up menu that appears.

7.11.2 Pasting All Copied Settings
This pastes all of the copied material settings into the selected material.

If multiple materials are selected, the copied settings will be pasted to all selected materials.

Operating Procedure
1. In the Object View select the material into which you want to paste the copied settings.

2. Select “Paste All Copied Settings” on the “Object” menu.
(Toolbar button: , Shortcut Keys: Ctrl + Shift + V)

You can also use the following method:

• Select a material in the Object View. Right-click with the mouse and select “Paste All Copied Settings” 
from the pop-up menu that appears.

Caution: Depending on the condition of the polygon vertex information (the existence of a normal vec-
tor or texture coordinates) that the paste-destination material references or the configuration 
of the paste-destination material, there may be cases where there are configurations cannot 
be pasted or the display of the pasted results on NITRO-Viewer will not be the same as the 
paste source.

7.11.3 Pasting Some Copied Settings
In this feature, first, from the copied material settings, select the contents that you want to paste, and then 
paste into the selected material.

If multiple materials are selected, the copied settings will be pasted to all selected materials.
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Operating Procedure
1. In the Object View select the material into which you want to paste the copied settings.

2. Select “Paste Special…” on the “Object” menu.
(Toolbar button: , Shortcut Keys: Ctrl + Shift + S)

3. A detail setting dialog box will appear (Figure 7-33). Select the items you want to paste and click the 
OK button.

Figure 7-33 - Pasting Copied Material Settings

A. Selects the content to paste.

Items are classified in each material property group. By switching the check state of parent items, 
the check state of all child items switches. For details of material properties corresponding to each 
item, see "7.7 Material Properties" on page 80.

B. This checks all items.

C. This removes the checks from all items.

A

CB
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You can also use the following method:

• Select a material in the Object View. Right-click with the mouse and select “Paste Special…” from the 
pop-up menu that appears.

Caution: Depending on the condition of the polygon vertex information (the existence of a normal vec-
tor or texture coordinates) that the paste-destination material references or the configuration 
of the paste-destination material, there may be cases where there are configurations cannot 
be pasted or the display of the pasted results on NITRO-Viewer will not be the same as the 
paste source.
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7.12 Displaying Properties in Separate Windows
By displaying the properties of the objects that are displayed in the Property View in separate windows, 
you can refer to more than one property at the same time (Figure 7-34).

For properties that are displayed in a separate window, even if you change a selected object in the Object 
View, the target object will not be changed.

Operating Procedure
1. In the Object View select the object whose properties you want to display in a separate window.

2. Select “Display Properties in Separate Window” on the “Object” menu.
(Toolbar button: , Shortcut Keys: Ctrl + P)

Figure 7-34 - Displaying Properties in Separate Windows

You can also use the following method:

• Select a material in the Object View. Right-click with the mouse and select “Display Properties in Sep-
arate Window” from the pop-up menu that appears.

Hint: You can display a maximum of ten separate property windows at one time.

Same contents as in the
Property View, but displayed
in a separate window
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8 Animation
8.1 Loading Animation Files
If an imd file has been loaded, it is possible to load the animation files for the imd file. There are five types 
of animation files. (Table 8-1)

Table 8-1 -  Animation Files

There are two ways to load animation files:

• Load by selecting files
• Load by dragging and dropping

Note: It is not possible to load animation files if no imd file has been loaded.

Note: Depending on the animation conditions that are set in the 3DCG, ima, itp, and ita files may 
be exported as files that contain no animation data. When loading this type of animation 
file, a warning message will appear.

8.1.1 Loading by Selecting File Names
An animation file is loaded by selecting its file name from the file selection dialog box. If the same type of 
animation file has already been loaded, the previous one will be discarded.

Operating Procedure
1. Select “Load Animation File” on the “File” menu and then “File Type”

(Toolbar Buttons:     )

2. A file selection dialog box will open (Figure 8-1). Select the animation file you want to load and click on 
the “Open” button.

Type of File Description

ica files Character animation data files

iva files Visibility animation data files

ima files Material color animation data files

itp files Texture pattern animation data files

ita files Texture SRT animation data files
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Figure 8-1 -  Loading an Animation File: Selecting a File Name

8.1.2 Loading by Dragging and Dropping
Dragging and dropping loads animation files.

It is possible to simultaneously open different types of animation files. If the same type of animation file is 
already loaded, the loaded file is overwritten.

Operating Procedure
1. Drag animation files and drop them anywhere in the main window.

Figure 8-2 - Loading an Animation File: Dragging and Dropping

Note: If you drag and drop multiple files of the same type, a dialog box will appear for selecting 
the animation file to load.

animation file

(2) Drop it anywhere in the window.

(1) Drag an animation file.
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8.2 Animation Operations
When the animation file is loaded, an animation view will appear in the bottom of the main window. 
(Figure 8-3) In the animation view, it is possible to switch animation between enable and disable, check the 
properties, and execute frame operations for previewing.

Frame operations in the animation view are possible only while NITRO-Viewer is connected.
If NITRO-Viewer is not connected, the frame operation control in the animation view will be disabled. For 
information on communications with NITRO-Viewer, see "9 Communications with NITRO-Viewer" on page 
121.

Figure 8-3 - Animation View

A. The following appear: the enable/disable state of the loaded animation, the file name, the property 
display button, and a bar that indicates the number of frames. (Figure 8-4) 

From the top, the sections correspond, in order, to the following animations:
• Character animation (ica files)
• Visibility animation (iva files)
• Material color animation (ima files)
• Texture pattern animation (itp files)
• Texture SRT animation (ita files)

If a corresponding animation file is not loaded, nothing will be displayed.

Figure 8-4 - Animation Information

The icon on the left edge displays the enable/disable state of the animation (Figure 8-5).

For animation in disabled state, the bar showing the number of frames is displayed in gray and is 
not played.

Clicking the icon switches the state.

A C 

DB

File name Property display button

Enable/disable state Bar that shows the number of animation frames
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Figure 8-5 - Animation Enable/Disable State

Press the property display button to display the property dialog box for each animation. For details 
about property dialog boxes, see "8.3 Animation Properties" on page 105.

For character animation, material color animation, and animation of the three types of texture SRT 
animation, information relating to playback with the decimal frame during animation playback is 
displayed in icon form at the right end of the bar that shows the number of frames (Table 8-2).

Table 8-2 - Information Related to Play Using the Decimal Frame

* For character animation files (ica), <node_anm_info>; for material color animation files (ima), 
<mat_color_info>; for texture SRT animation files (ita), <tex_srt_info>.

Note: Some versions of NITRO-Viewer do not support linear interpolation play for material color 
animation, or texture SRT animation sub frames. For details see the NITRO-Viewer 
manual.

B. This region is for operating on animation frames that are displayed in NITRO-Viewer.

The current frame is indicated by a red line. You can change the value by left-clicking with the 
mouse or by dragging. You can set this value within the range of the maximum number of frames 
of all the animations that have been loaded, and apply it in common to all animations. (Figure 8-6)

Icon Description

Plays by omitting decimal frame and handling as integer frame. 
Corresponds to the attribute interpolation=frame for the 
<***_info> element (*) in each animation file.

Searches for and plays value in/with decimal frame as is without 
omitting decimal frame, using line interpolation. Does not interpolate 
from the last frame to the first frame. Corresponds to the attributes 
interpolation=linear, interp_end_to_start=off for the 
<***_info> element (*) in each animation file.

Searches for and plays value in/with decimal frame as is without 
omitting decimal frame, using line interpolation. Interpolates from 
the last frame to the first frame. Corresponds to the attributes 
interpolation=linear, interp_end_to_start=on for the 
<***_info> element (*) in each animation file.

Enable state

Disable state
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Figure 8-6 - Current Frame: 1

If each animation has a different number of frames, and if the current frame number exceeds the 
number in an animation, the last frame of that animation will be displayed. (Figure 8-7)

Figure 8-7 - Current Frame: 2

While animation is playing, each bar is displayed in red (Figure 8-8).

Figure 8-8 - During Animation Play

Note: The 3D Material Editor handles the display frames of all animations together. It is not 
possible to specify a different display frame for each animation.

C. This button is for animation play, stop, etc. Button functions are shown in Table 8-3.

Frame 30 of all of the animations will be
displayed

Displays the last frame in the
animation
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Table 8-3 - Animation Operation Buttons

Hint: The similar operation as pressing the above-mentioned animation operation button can be 
done with the button operation in NITRO-Viewer. For details on the operation procedure, see 
the NITRO-Viewer manual.

D. This sets the following:

• Loop Play

Selects whether or not to loop animation and play.

When loop playing, animation that is playing or reverse playing continues to loop until the stop 
button is pushed. During not loop playing, play stops automatically when the playing animation 
reaches the final frame, or when the reverse playing animation reaches the starting frame.

• Current Frame

Directly specifies the animation frame to view with NITRO-Viewer. You cannot change this 
while playing forward or reverse animation.

• Number of Frames

Displays the total number of frames in an animation. This is the largest value of all the anima-
tions that have been loaded. It cannot be changed.

• Frame Change Amount

This sets the number of frames that will be added (or reduced) for 1 game frame when an ani-
mation is played (or played in reverse). You cannot change this while playing forward or 
reverse animation.

Button Description

Sets the current frame back to the start frame.

Sets the current frame back by Frame Change Amount (D in 
Figure 8-6).

Begins playing the animation in reverse.
During reverse animation, it changes to the Stop button. (*).

Begins playing animation.
During play, it changes to the Stop button. (*).

Advances the current frame by Frame Change Amount (D in 
Figure 8-6).

Advances the current frame to the last frame.

* Stops animation during play or reverse animation.
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8.3 Animation Properties
A property dialog box is displayed for each type of animation.

8.3.1 ica Property Dialog Box
There are two pages in the ica dialog box.

• General page

• Data Details page

8.3.1.1 General
Information on the entire animation is displayed. (Figure 8-9)

Figure 8-9 - ica Property Dialog Box: General

A. The animation frame count. It corresponds to the attribute frame_size of the ica file 
<node_anm_info> element.

B. The StartFrame that was specified when the file was output from 3DCG tool. It corresponds to the 
attribute tool_start_frame of the ica file <node_anm_info> element.

A

B

C

D

E

F

G

H

I

J

K

L

M
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C. The EndFrame that was specified when the file was output from the 3DCG tool. It corresponds to 
the attribute tool_end_frame of the ica file <node_anm_info> element.

D. The method when searching for and playing values in the decimal frame when playing animation. 
One of the following types is selected.
• Frame
• Linear

It corresponds to the attribute interpolation of the ica file <node_anm_info> element.

E. The flag that determines whether to use linear interpolation between the last frame and the first 
frame. The flag D is displayed only when it is set to Linear. It corresponds to the attribute 
interp_end_to_start of the ica file <node_anm_info> element.

F. How to calculate the scale. At this point, one of these three types is selected.
• Normal
• Maya method
• Softimage method

It corresponds to the attribute scaling_rule of the ica file <node_anm_info> element.

G. The scaling factor that is applied to the entire model when the file is output from the 3DCG tool. It 
corresponds to the attribute magnify of the ica file <node_anm_info> element.

H. The compressed status of the node that was output. One of these five types is selected.
• None
• Cull
• Merge
• Unite
• Unite Combine

It corresponds to the attribute compress_node of the ica file <node_anm_info> element.

I. The number of uncompressed and compressed nodes. If the nodes are not compressed, only the 
number of uncompressed nodes are displayed. It corresponds to the attribute node_size of the 
ica file <node_anm_info> element.

J. Specifying data for thinning out. One of these four types is selected.
• 1
• 2
• 4
• Auto

It corresponds to the attribute frame_step_mode of the ica file <node_anm_info> element.

K. The margin of error allowed for thinning out the scale data. It corresponds to the attribute 
tolerance_scale of the ica file <node_anm_info> element.

L. The margin of error allowed for thinning out the rotate data. It corresponds to the attribute 
tolerance_rotate of the ica file <node_anm_info> element.

M. The margin of error allowed for thinning out the translate data. It corresponds to the attribute 
tolerance_translate of the ica file <node_anm_info> element.
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8.3.1.2 Data Details
Information on the animation data is displayed. (Figure 8-10)

Figure 8-10 - ica Property Dialog Box: Data Details

A. The amount of scale data. It corresponds to the attribute size of the ica file 
<node_scale_data> element.

B. The amount of rotate data. It corresponds to the attribute size of the ica file <node_ rotate_data> 
element.

C. The amount of translate data. It corresponds to the attribute size of the ica file 
<node_translate_data> element.

A

B

C
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8.3.2 iva Property Dialog Box
There are two pages in the iva property dialog box.

• General page

• Data Details page

8.3.2.1 General
Information on the entire animation is displayed. (Figure 8-11)

Figure 8-11 - iva Property Dialog Box: General

A. The number of animation frames. It corresponds to the attribute frame_size of the iva file 
<visibility_info> element.

B. The StartFrame specified when a file is output from 3DCG tool. It corresponds to the attribute 
tool_start_frame of the iva file <visibility_info> element.

C. The EndFrame specified when a file is output from 3DCG tool. It corresponds to the attribute 
tool_end_frame of the iva file <visibility_info> element.

A

B

C

D

E
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D. The compression status of the node that was output. One of these five types is selected.
• None
• Cull
• Merge
• Unite
• Unite Combine

It corresponds to the attribute compress_node of the iva file <visibility_info> element.

E. The number of uncompressed and compressed nodes. If the nodes are not compressed, only the 
number of uncompressed nodes are displayed. It corresponds to the attribute node_size of the 
iva file <visibility_info> element.

8.3.2.2 Data Details
Detailed information on the entire animation is displayed. (Figure 8-12)

Figure 8-12 - iva Property Dialog Box: Data Details

A. The amount of frame number data. It corresponds to the attribute size of the iva file 
<frame_idx> element.

B. The amount of visibility data. It corresponds to the attribute size of the iva file 
<visibility_data> element.

A

B
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8.3.3 ima Property Dialog Box
There are three pages in the ima property dialog box.

• General page

• Data Details page

• Applied Materials page

8.3.3.1 General
Information on the entire animation is displayed. (Figure 8-13)

Figure 8-13 - ima Property Dialog: General

A. The number of animation frames. It corresponds to the attribute frame_size of the ima file 
<mat_color_info> element.

B. The StartFrame that was specified when the file was output from the 3DCG tool. It corresponds to 
the attribute tool_start_frame of the ima file <mat_color_info> element.

C. The EndFrame that was specified when the file was output from the 3DCG tool. It corresponds to 
the attribute tool_end_frame of the ima file <mat_color_info> element.

A

B

C

D

E

F

G

H

I
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D. Method when searching for and playing values in the decimal frame during animation playback. 
One of these two types is selected.
• Frame
• Linear

It corresponds to the attribute interpolation of the ima file <mat_color_info> element.

Depending on the version of NITRO-Viewer, there are cases where line interpolation play for 
decimal frame of material color animation may not be supported (decimal frame is omitted, and 
play occurs with it treated as integer frame). For details, see the NITRO-Viewer manual.

E. The flag that determines whether to use linear interpolation between the last frame and the first 
frame. Displayed only when the flag in D is set to Linear. It corresponds to the attribute 
interp_end_to_start of the ima file <mat_color_info> element.

F. Indicates whether the material is compressed. It corresponds to the attribute 
compress_material of the ima file <mat_color_info> element.

G. The number of compressed and uncompressed materials. If the materials are not compressed, 
only the number of uncompressed materials is displayed. It corresponds to the attribute 
material_size of the ica file <mat_color_info> element.

H. Specifying data for thinning out. One of these four types is selected.
• 1
• 2
• 4
• Auto

It corresponds to the attribute tolerance_color of the ima file <mat_color_info> element.

I. The margin of error allowed for thinning out the color data. It corresponds to the attribute 
tolerance_color of the ima file <mat_color_info> element.
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8.3.3.2 Data Details
Information on the animation data is displayed. (Figure 8-14)

Figure 8-14 - ima Property Dialog Box: Data Details

A. The amount of color data. It corresponds to the attribute size of the ima file <mat_color_data> 
element.

A
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8.3.3.3 Applied Materials
Displays information regarding the material to which the animation is applied. (Figure 8-15)

Figure 8-15 - ima Property Dialog Box: Applied Materials

A. The number of materials to which the animation is applied, as specified in the ima file. It corre-
sponds to the attribute size of the ima file <mat_color_anm_array> element.

B. Of the number of materials shown in A, this is the number of materials that matched the material 
names and was applied to imd. The materials specified in the ima file that were applied to imd are 
shown in blue. The materials not applied to imd are shown in red.

C. A list of materials to be applied to the animation. The materials applied to imd are shown, with the 
index in imd shown on the right. The icons are crossed out for the materials not applied to imd.

A

B

C
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8.3.4 itp Property Dialog Box
There are three pages in the itp property dialog box.

• General page

• Data Details page

• Applied Materials page

8.3.4.1 General
Information on the entire animation is displayed. (Figure 8-16)

Figure 8-16 - itp Property Dialog Box: General

A. The number of frames in the animation. It corresponds to the attribute frame_size of the itp file 
<tex_pattern_info> element.

B. The StartFrame that was specified when the file was output from the 3DCG tool. It corresponds to 
the attribute tool_start_frame of the itp file <tex_pattern_info> element.

C. The EndFrame that was specified when the file was output from the 3DCG tool. It corresponds to 
the attribute tool_end_frame of the itp file <tex_pattern_info> element.

D. Indicates whether the material is compressed. It corresponds to the attribute 
compress_material of the itp file <tex_pattern_info> element.

A

B

C

D

E
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E. The number of uncompressed and compressed materials. If the materials are not compressed, 
only the number of uncompressed materials are displayed. It corresponds to the attribute 
material_size of the itp file <tex_pattern_info> element.

8.3.4.2 Data Details
Detailed information on the animation is displayed. (Figure 8-17)

Figure 8-17 - itp Property Dialog Box: Data Details

A. The amount of frame number data. It corresponds to the attribute size of the itp file 
<frame_idx> element.

B. The amount of texture image number data. It corresponds to the attribute size of the itp file 
<image_idx> element.

C. The amount of palette number data. It corresponds to the attribute size of the itp file 
<palette_idx> element.

D. A list of texture that is specified in the itp file to be used for the animation. When there is no corre-
sponding texture in imd, the icon is crossed out. By selecting each texture name, the color image 
of the texture and palette image (only when the format requires the palette) are displayed on the 
right.

A

B

C

E

F

D
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E. The color image of the texture that is selected in D. When there is no corresponding texture in imd, 
nothing is displayed.

F. The palette image of the palette that is referenced by the texture selected in D. Displayed only if 
the texture is in the format that uses the palette. When there is no corresponding palette in imd, 
nothing is displayed.

8.3.4.3 Applied Materials
Displays information regarding the material to which the animation is applied. (Figure 8-18)

Figure 8-18 - itp Property Dialog Box: Applied Materials

A. The number of materials that are applied to the animation, as specified in the itp file. It corre-
sponds to the attribute size of the itp file <tex_pattern_anm_array> element.

B. Of the number of materials shown in A, this is the number of materials that matched the material 
names and was applied to imd. The materials in the itp file that were applied to imd are shown in 
blue. The materials that were not applied to imd are shown in red.

C. A list of materials to be applied to the animation. The materials applied to imd are shown, with the 
index in imd on the right. The icons are crossed out for the materials not applied to imd.

A

B

C
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8.3.5 ita Property Dialog Box
There are three pages in the ita property dialog box.

• General page

• Data Details page

• Applied Materials page

8.3.5.1 General
Information on the entire animation is displayed. (Figure 8-19)

Figure 8-19 - ita Property Dialog Box: General

A. The number of frames in the animation. It corresponds to the attribute frame_size of the ita file 
<tex_srt_info> element.

B. The StartFrame that was specified when the file was output from the 3DCG tool. It corresponds to 
the attribute tool_start_frame of the ita file <tex_srt_info> element.

C. The EndFrame that was specified when the file was output from the 3DCG tool. It corresponds to 
the attribute tool_end_frame of the ita file <tex_srt_info> element.
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D. When playing animation, this is the method when searching for and playing the value in the 
decimal frame. One of these two types is selected.
• Frame
• Linear

It corresponds to the attribute interpolation of the ita file <tex_srt_info> element.

Depending on the version of NITRO-Viewer, there are cases where line interpolation play for 
decimal frame of texture SRT animation may not be supported (decimal frame is omitted, and play 
occurs with it treated as integer frame). For details, see the NITRO-Viewer manual.

E. The flag that determines whether to use linear interpolation between the last frame and the first 
frame. The flag mentioned in D is displayed only when it is set to Linear. It corresponds to the 
attribute interp_end_to_start of the ita file <tex_srt_info> element.

F. This is the texture matrix calculation method. Currently, it will be one of these four methods:
• Maya method
• SOFTIMAGE|3D method
• SOFTIMAGE|XSL method
• 3ds max method

It corresponds to the attribute tex_matrix_mode of the ita file <tex_srt_info> element.

G. Indicates whether the material is compressed. It corresponds to the attribute 
compress_material of the ita file <tex_srt_info> element.

H. The number of uncompressed and compressed materials. When there is no compressed material, 
only the number of uncompressed material is displayed. It corresponds to the attribute 
material_size of the ita file <tex_srt_info> element.

I. Specifying data for thinning out. One of these four types is selected.
• 1
• 2
• 4
• Auto

It corresponds to the attribute frame_step_mode of the ita file <tex_srt_info> element.

J. The margin of error allowed for thinning out the scale data. It corresponds to the attribute 
tolerance_tex_scale of the ita file <tex_srt_info> element.

K. The margin of error allowed for thinning out the rotate data. It corresponds to the attribute 
tolerance_tex_rotate of the ita file <tex_srt_info> element.

L. The margin of error allowed for thinning out the translate data. It corresponds to the attribute 
tolerance_tex_translate of the ita file <tex_srt_info> element.
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8.3.5.2 Data Details
Detailed information on the animation data is displayed. (Figure 8-20)

Figure 8-20 - ita Property Dialog Box: Data Details

A. The amount of scale data. It corresponds to the attribute size of the ita file <tex_scale_data> 
element.

B. The amount of rotate data. It corresponds to the attribute size of the ita file 
<tex_rotate_data> element.

C. The amount of translate data. It corresponds to the attribute size of the ita file 
<tex_rotate_data> element.
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8.3.5.3 Applied Materials
Displays information about the materials to which the animation is applied. (Figure 8-21)

Figure 8-21 - ita Property Dialog Box: Applied Materials

A. The number of materials to which the animation is applied, as specified in the ita file. It corre-
sponds to the attribute size of the ita file <tex_srt_anm_array y> element.

B. Of the number of materials shown in A, the number of materials that matched the material names 
and was applied to imd. The materials specified in the ita file that were applied to imd are shown in 
blue. The materials that were not applied to imd are shown in red.

C. A list of materials to be applied to the animation. The materials that were applied to imd are shown, 
with the index in imd on the right. The icons are crossed out for materials not applied to imd.

A

B
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9 Communications with NITRO-Viewer
This chapter describes previewing models and animations by communicating with NITRO-Viewer.

9.1 Overview
By connecting the 3D Material Editor to NITRO-Viewer, you can preview models and animations that are 
loaded into the 3D Material Editor on the production unit.

Once it is connected to NITRO-Viewer, when you use the 3D Material Editor to change a graphics scene or 
material setting, or operate on animation frames, you will be able to check them on the retail product in real 
time (Figure 9-1).

Figure 9-1 - Communicating with NITRO-Viewer

Note: In order to communicate with NITRO-Viewer, NITRO-Viewer and NITRO-Viewer controller must 
have been started properly. For details on using NITRO-Viewer and NITRO-Viewer Controller see 
their respective manuals.

Note: The models that can be previewed with NITRO-Viewer can contain nodes, materials, and 
polygons, but no more than 64 of each (due to a limitation in the NITRO-System library). If the 
nodes, materials, or polygons exceed 64, the model may not be displayed properly.
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3D Material Editor
9.2 Connecting to and Disconnecting from NITRO-Viewer
You can connect to and disconnect from NITRO-Viewer at any time.

9.2.1 Connect to NITRO-Viewer
This connects to NITRO-Viewer and transfers the data required for preview.

Operating Procedure

1. Select “Connect” on the “NITRO-Viewer” menu. (Toolbar button: , Shortcut key: F5)

2. A dialog box shows the status of the data transfer to NITRO-Viewer (Figure 9-2). If the transfer 
succeeds, the dialog box will close, and the system will be in connected status.

Figure 9-2 - Transferring Data to NITRO-Viewer

A. Creating data to transfer to NITRO-Viewer. Time required for this depends on the size and content 
of the model and animation data that will be transferred.

B. Transferring data to NITRO-Viewer. Time required for this depends on the size and content of the 
model and animation data that will be transferred.

C. Data transfer complete. Waiting for a response from NITRO-Viewer.

Note: If a communications error occurs during data transfer to NITRO-Viewer, an error message will 
appear, and the connect process will be terminated.

Note: Only one 3D Material Editor can be connected to NITRO-Viewer at one time. To connect from 
another of multiple, running 3D Material Editors, you must first disconnect the connected 3D 
Material Editor from NITRO-Viewer.

Hint: If you load imd files or animation files while you are connected to NITRO-Viewer, data will be 
transferred automatically.

9.2.2 Disconnecting from NITRO-Viewer
This disconnects communications with NITRO-Viewer.

Operating Procedure

1. Select “Disconnect” on the “NITRO-Viewer” menu. (Toolbar: , Shortcut key: Shift + F5)

Note: If a communications error occurs during data transfer to NITRO-Viewer, an error message will 
appear, and disconnection will be automatic.

A

C

B

Proceeds in 
alphabetical 
order
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NITRO-Viewer Settings
9.2.3 NITRO-Viewer Connection Status
An icon that indicates the status of the connection to NITRO-Viewer is displayed on the right side of the 
status bar. This icon will tell you whether the 3D Material Editor is connected to NITRO-Viewer (Table 9-1)
Table 9-1 - NITRO-Viewer Connection Status

9.3 NITRO-Viewer Settings
You can change NITRO-Viewer display and operation settings from the 3D Material Editor. You can 
manage NITRO-Viewer settings by preparing multiple types and attaching names. Depending on your use 
of NITRO-Viewer, you can freely create, delete and switch.

Operating Procedure

1. Select “Settings” on the “NITRO-Viewer” menu. (Toolbar button: )

2. A NITRO-Viewer setting dialog box will appear (Figure 9-3). Change settings on each dialog page. For 
details on the dialog boxes, see “NITRO-Viewer Settings Dialog Boxes” on page 124

Figure 9-3 - NITRO-Viewer Settings

Icon Status

Connected to NITRO-Viewer.

Not connected to NITRO-Viewer.
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3D Material Editor
9.3.1 NITRO-Viewer Settings Dialog Boxes
The NITRO-Viewer Settings dialog box is shown in Figure 9-4.

Figure 9-4 - NITRO-Viewer Settings Dialog Box: Full

A. Settings currently being used.

Select from among the created settings.

B. These buttons perform the following operations (Table 9-2).

A

C

B
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NITRO-Viewer Settings
Table 9-2 - Toolbar Buttons

Note: NITRO-Viewer setting files (.menvs) used in setting import and export are 3D material editor 
files. They are not related to NITRO intermediate files or NITRO-System library.

C. The details of the currently used settings are displayed.

The settings are divided into the following types of pages.
• View page
• Action page
• Data Transfer page

Button Description

Creates new settings.

The name input dialog box opens. Input the setting name.

Makes a copy of the current settings.
The name input dialog box opens. Input the setting name.

Changes name of current setting.

The name input dialog box opens. Input the setting name.

Deletes the current setting.
You cannot delete when there is only one setting.

Imports NITRO-Viewer setting file (.menvs) and adds 
settings.

Exports current settings as NITRO-Viewer setting file 
(.menvs).
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3D Material Editor
9.3.1.1 View
Creates settings related to NITRO-Viewer display (Figure 9-5).

Figure 9-5 - NITRO-Viewer Settings Dialog Box: View

A. Shows/Hides the coordinate system (grid/axes).

B. Shows/Hides focal point shape.

C. Shows/Hides the shape that represents light 0.

By turning on Auto-Switch on the right side, shape show/hide automatically switches according to 
the effect flag setting of light 0 of each material.

D. Shows/Hides the shape that represents light 1.

By turning on Auto-Switch on the right side, shape show/hide automatically switches according to 
the effect flag setting of light 1 of each material.

E. Shows/Hides the shape that represents light 2.

By turning on Auto-Switch on the right side, shape show/hide automatically switches according to 
the effect flag setting of light 2 of each material.

A

C

B

E

D

F

G

I

H

J

L

K

M N O
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NITRO-Viewer Settings
F. Shows/Hides the shape that represents light 3.

By turning on Auto-Switch on the right side, shape show/hide automatically switches according to 
the effect flag setting of light 3 of each material.

G. Shows/Hides the icon at the bottom left of the NITRO-Viewer screen that indicates the target of the 
controller operation.

H. Show/Hide the process meter that appears at the left of the NITRO-Viewer screen.

I. Show/Hide the animation bar that appears at the bottom of the NITRO-Viewer screen.

J. Shows all information.

No effect on shape showing each light set to Auto-Switch.

K. Hides all information.

No effect on shape showing each light set to Auto-Switch.

L. Selects which of the following coordinate systems to display:
• Grid (XZ plane)
• Coordinate Axes

M. Sets the size of the grid, axis graduations.

N. Sets the number of grid, axis graduations.

O. Sets grid color. This is only possible when grid display is specified.
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9.3.1.2 Action
Creates settings for NITRO-Viewer operation (Figure 9-6).

Figure 9-6 - NITRO-Viewer Settings Dialog Box: Action

A. Select game frame rate.

B. Select each operation mode of lights 0-3 from the following three types.

Table 9-3 - Light Operation Modes

Operation Mode Description

Move Independently Moves independently.

Track Camera When the camera direction changes, the direction of 
the light moves with it.

Enables manipulation of the light itself.

Match Camera Direction The direction of the light always matches the direction 
of the camera.

Manipulation of the light itself is not possible.
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NITRO-Viewer Settings
C. Specifies whether to make the corresponding shape blink when selecting the node in object view.

D. Specifies whether to make the corresponding shape blink when selecting the polygon in object view.

E. Specifies whether to make the corresponding shape blink when selecting the material in object view.

F. Sets the number of times that a shape will blink when an object is selected.

G. Specifies the number of frames in order to set the blink interval that a shape will have when an 
object is selected. Does not affect the game frame rate setting.

9.3.1.3 Data Transfer
This makes settings related to the data transfer to NITRO-Viewer. (Figure 9-7)

Figure 9-7 - NITRO-Viewer Settings Dialog Box: Data Transfer

A. When transforming an ica file, for all nodes other than the root node, the ica file's Scale data is 
ignored and the model's Scale data is used.

B. When transforming an ica file, for all nodes other than the root node, the ica file's Rotate data is 
ignored and the model's Rotate data is used.

C. When transforming an ica file, for all nodes other than the root node, the ica file's Translate data is 
ignored and the model's Translate data is used.

D. Automatically play back the animation after the animation data transfer.

A

C

B

D
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3D Material Editor
Note: Settings made in the ica file conversion option are used for binary transformations that are 
performed when transferring data to NITRO-Viewer. Therefore, in order for changes to take 
effect, you must re-transfer to NITRO-Viewer.

9.4 Static Model Settings
The 3D Material Editor allows you to save and control secondary models that are static and always 
displayed in NITRO-Viewer. This feature is in addition to the preview of normal models in NITRO-Viewer.  

These models are called “static models” in the 3D Material Editor and are used for the following 
applications. 

• When designing a character model, an existing terrain model is positioned for comparison purposes. 

• When designing a terrain model, an existing character model is positioned for comparison purposes. 

• A model is designed while comparing size and color to an existing model. 

Multiple static models can be managed in units of imd files. Once a model is saved, upon connection to 
NITRO-Viewer, the model data is automatically transferred and the model is displayed with the specified 
position and size. 

A static model differs from a normal model in some ways. You cannot see the internal structure of a static 
model, nor make material settings for it.

Operating Procedure

1. Select "Static Model Settings" from the "NITRO-Viewer" Menu. (Toolbar button: , Shortcut key: Shift + F6)

The Static model setting dialog box appears (Figure 9-8).

2. Save or delete models and make display settings.

Figure 9-8 - Static Model Settings Dialog Box

A. Currently saved models. 

Selects from the saved models. When the selection is changed, the displayed settings will change. 
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Output the Snapshot Image
B. Reads an imd file and saves a model. If a model of the same name is already saved, it will be 
overwritten. 

C. Deletes the selected model. 

D. Changes the name of the selected model. The name input dialog box will open. Enter the model 
name. 

E. Selects whether to display or hide the model. This is useful for hiding the model temporarily. 

F. Sets the model display magnification. 

G. Sets the model’s rotation angle around the Y axis. 

H. Sets the model’s display position.

9.5 Output the Snapshot Image
The images that are displayed in NITRO-Viewer can be output as image files. Image files are output with 
the size of 256 x 192 (screen size of NITRO) in bitmap file format (bmp file).

Operating Procedure

1. Select “Output the snapshot image” from “NITRO-Viewer” menu. (Toolbar button: , Shortcut key: F7) 
The Image file save dialog box appears. (Figure 9-9)

2. Specify the folder and file name to save, and press the “Save” button.

Figure 9-9 - Output the Snapshot Image

A
B
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3D Material Editor
A. Makes the display information such as coordinate axes, icons, and bars that are other than the 
model to be excluded from the output image.

B. Opens the image file in the previously arranged application (the application that is associated with 
bmp files) after the output of image files.

Note: Snapshot images are created by using NITRO’s display capture feature (feature that loads the 
image to VRAM), so the color precision is different from the image shown in NITRO-Viewer. In 
addition, the snapshot image may not be generated properly depending on the VRAM alloca-
tion condition that is set with NITRO-Viewer controller.

Hint: When displaying 2D screen in NITRO-Viewer simultaneously by using NITRO-CHARACTER, 
both 3D model and 2D screen are incorporated into the snapshot image.

9.6 Display of VRAM Contents
This function gets the current VRAM usage conditions from NITRO-Viewer, and displays detailed VRAM 
position conditions for texture and palette data.

By using this function, you can visually check the VRAM usage of models displayed in the NITRO-Viewer. 

Operating Procedure

1. Select "Display VRAM contents" from the "NITRO-Viewer" Menu. (Toolbar button: , Shortcut key: F8)

The dialog box that shows the current VRAM usage conditions is displayed (Figure 9-10).

2. Confirm the contents and press the OK Button.

Figure 9-10 - VRAM Conditions Dialog Box
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Display of VRAM Contents
A. List of the model’s textures and palettes.

When an item is selected, the data details are displayed in B and the area in VRAM is highlighted 
in the red box in C.

B. The details of the texture or palette selected in A.

Under the thumbnail image, the image size (width x height), format, and data size are displayed if 
a texture is selected, and the palette color count and data size are displayed if a palette is 
selected.

C. Usage conditions for VRAM-A through VRAM-G.

To the left of each VRAM, the VRAM name and VRAM size are displayed. To the right, the data 
size used and utilization ratio are displayed.

The data stored in each VRAM is color-coded according to type and displayed at its address. 

Table 9-4 - VRAM Status Color Codes

D. Show or hide the display of static model usage areas.

If you only want to see the utilization ratio of texture data and palette data used by the model, clear 
this checkbox.

Color Description

Unused area.

Texture data area.

4x4 texel compressed texture palette index data area.

Palette data area.

Area used for static model texture data and palette data.

For information on static models, see “Static Model Settings” on 
page 130.

VRAM allocated for 2D data.

You can change the VRAM allocation using the NITRO-Viewer Controller.
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10 Working with 3DCG Tool Plug-ins
This chapter describes how the 3D Material Editor works in conjunction with 3DCG tool plug-ins.

10.1 Overview
To use the 3D Material Editor and NITRO-Viewer to preview models and animation made with a 3DCG 
tool, use the following procedure:
1. Use the NITRO intermediate file output plug-in for the 3DCG tool to output a NITRO intermediate file.

2. Start the 3D Material Editor.

3. Use the 3D Material Editor to Load the NITRO intermediate file.

4. Transfer data from the 3D Material Editor to NITRO-Viewer, and preview.

The 3D Material Editor works in conjunction with the 3DCG tool’s NITRO intermediate file output plug-in to 
automate these procedures. Using this, from the 3DCG tool you can start the 3D Material Editor, load the 
NITRO intermediate files, and transfer data to the NITRO-Viewer, all in a single process. (Figure 10-1).

Figure 10-1 - Working in Conjunction with 3DCG Tool Plug-ins

Caution: NITRO Intermediate files transferred from a 3DCG tool to the 3D Material Editor are treated 
as temporary files, used only for data transfer. Therefore, when you save an imd file after the 
data transfer, you must explicitly save it from the 3D Material Editor.

Caution: If the 3D Material Editor is already running when you transfer data from a 3DCG tool, all data 
content that had been edited on the 3D Material Editor will be discarded. It will not prompt 
you to confirm the save.

Caution: In order to automatically preview on NITRO-Viewer, NITRO-Viewer and the NITRO-Viewer 
Controller must have been started properly.

3DCG Tool 3D Material Editor

NITRO Intermediate files
NITRO

Intermediate file
output plug-in Output Start and Load

Automate as a single process

Transfer Data

NITRO-Viewer
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10.2 Transferring Data to the 3D Material Editor
To transfer data from a 3DCG tool to the 3D Material Editor, specify the following items in the 3DCG tool’s 
NITRO intermediate file output plug-in window (dialog box) (Figure 10-2).

In the diagram we are using the Maya plug-in window as an example.
1. Select “Use 3D Material Editor” in “Output Options.”

2. When transferring an imd file you can specify an imd file to merge-load. In this case, merge-load with 
the specified imd file will be performed automatically after the data has been transferred. 

If you specify a merge-load imd file, check “Merge Imd File”, and specify the path to the imd file. For 
information on merge loading imd files, see "5.3 Merge-Loading imd Files" on page 25.

Figure 10-2 - Transferring Data to the 3D Material Editor

Caution: The layout of the NITRO intermediate file output plug-in window is different for each 3DCG 
tool. For details, see the NITRO intermediate file output plug-in manual for each 3DCG tool.

Caution: When you automatically merge-load imd files after transferring data, you will not be able to 
set merge-load details. If you want to set details, perform merge-load from the 3D Material 
Editor. For information on setting the details of a merge-load, see "5.3.4 The Merge-Load 
Setting Dialog Box" on page 28.

Hint: If an imd file has already been transferred to the 3D Material Editor, it is possible to send only 
the animation file. In this case, when you specify file types for transfer, only specify animation 
files.
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11 Other Features
This chapter describes other features in the 3D Material Editor.

11.1 Undoing and Redoing Edit Operations
The 3D Material Editor saves a history of editing operations. It creates a history for the following opera-
tions:
• Switching current Graphics Scenes.
• Adding, removing, and renaming Graphics Scenes.
• Editing the properties of each object.
• Pasting copied material settings.

For any of the above you can undo an editing operation (Undo) or do it over (Redo).

Hint: The number of iterations in the operation history is not limited. Only the memory capacity limits it.

11.1.1 Undoing an Edit Operation (Undo)
This undoes an edit operation.

Operating Procedure
1. Select “Undo” on the “Edit” menu.

(Toolbar button: , Shortcut Keys: Ctrl + Z)

11.1.2 Redoing an Edit Operation (Redo)
This redoes an operation that you undid.

Operating Procedure
1. Select “Redo” on the “Edit” menu.

(Toolbar button: , Shortcut Keys: Ctrl + Y)

11.2 Language Settings
This allows you to select English or Japanese as the display language for the application.

Operating Procedure
1. Select “Language Settings” on the “Tools” menu.

2. This will open a language setting dialog box (Figure 11-1). Select a language and click the OK button. 
The selection will be enabled when you restart the 3D Material Editor.
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Figure 11-1 - Language Settings

Note: These language settings are not applied to Windows common dialog (file selection dialog boxes, 
standard message boxes, etc). Windows common dialog uses the language that is set by the 
operating system.
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12 Appendix

12.1 Menu List
The main menu contains the following menu items:
• File menu
• Edit menu
• View menu
• Graphics Scene menu
• Object menu
• Nitro-Viewer menu
• Tools menu
• Help menu

12.1.1 File
This performs operations related to file input and output.

12.1.2 Edit
This performs operations related to editing.

Operation Description

Open imd file (Ctrl + O) Opens an imd file.

Merge-Load imd file (Ctrl + M) Opens an imd file and merges it with the currently open 
imd file.

Load Animation File −> ica file Loads an ica file.

Load Animation File −> iva file Loads an iva file.

Load Animation File −> ima file Loads an ima file.

Load Animation File −> itp file Loads an itp file.

Load Animation File −> ita file Loads an ita file.

Save imd File (Ctrl + S) Saves an imd file by overwriting.

Save imd File As (Ctrl + A) Gives an imd file a name and saves it.

Exit Ends the application.

Operation Description

Undo (Ctrl + Z) Undoes an edit operation.

Redo (Ctrl + Y) Redoes an edit operation.
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12.1.3 View
This performs display-related operations.

Operation Description

Toolbar −> Standard Displays/Hides the Standard toolbar.

Toolbar −> View Displays/Hides the View toolbar.

Toolbar −> Graphics Scene Displays/Hides the Graphics Scenes toolbar.

Toolbar −> Object Displays/Hides the Object toolbar.

Toolbar −> NITRO-Viewer Displays/Hides the NITRO-Viewer toolbar.

Status Bar Displays/Hides the Status Bar.

View Mode −> Schematic View (Ctrl + 1) Sets the Object View display mode to Schematic View.

View Mode −> Tree View (Ctrl + 2) Sets the Object View display mode to Tree View.

View Mode −> Node List View (Ctrl + 3) Sets the Object View display mode to Node List View.

View Mode −> Polygon List View (Ctrl + 4) Sets the Object View display mode to Polygon List View.

View Mode −> Material List View (Ctrl + 5) Sets the Object View display mode to Material List View.

View Mode −> Texture List View (Ctrl + 6) Sets the Object View display mode to Texture List View.

View Mode −> Palette List View (Ctrl + 7) Sets the Object View display mode to Palette List View.

Property View (F4) Displays/Hides Property View.

Schematic View −> View all in Center When in Schematic View mode, displays all in the center of the View.

Schematic View −> View Selected Object 
in Center

When in Schematic View mode, displays the selected object in the 
center of the View.

Schematic View −> Align All Objects When in Schematic View mode, aligns all objects.

Schematic View −> Align Below Selected 
Object

When in Schematic View mode, aligns below the selected object.

Display List −> Reset the Order of Columns When in Display List mode, the order of columns are returned to the 
default state.

Display List −> Reset the Column Width When in Display List mode, the column width are returned to the 
default state.
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12.1.4 Graphics Scene
This performs operations related to Graphics Scenes.

12.1.5 Object
This performs operations related to selected objects.

Operation Description

Switch Scenes −> (Graphics Scene Name) Switches the Current Graphics Scene.

New Makes a new Graphics Scene.

Copy (Current Graphics Scene name) Copies the Current Graphics Scene.

Rename (Current Graphics Scene name) Renames the Current Graphics Scene.

Delete (Current Graphics Scene name) Deletes the Current Graphics Scene.

Import isd file Imports an isd file, adding a Graphics Scene.

Export isd file Exports the Current Graphics Scene as an isd file.

Operation Description

Select −> Graphics Scene Selects a graphics scene.

Select −> Model Selects a model.

Select −> All Nodes Selects all nodes.

Select −> All Polygons Selects all polygons.

Select −> All Materials Selects all materials.

Select −> All Textures Selects all textures.

Select −> All Palettes Selects all palettes.

Select −> Deselect Deselects an object.

View Properties in Separate Window (Ctrl + P) Displays an object’s properties in a separate window.

Material −> Copy Settings (Ctrl + Shift + C) Copies material settings.

Material −> Paste All Copied Settings (Ctrl + 
Shift + V)

Pastes all of the copied material settings.

Material −> Paste Special... (Ctrl + Shift + S) Selects part of the copied material settings and pastes them.
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12.1.6 NITRO-Viewer
This performs operations related to communications with NITRO-Viewer.

12.1.7 Tools
This changes settings for the entire application.

12.1.8 Help
This displays version information.

Operation Description

Connect (F5) Connects to NITRO-Viewer.

Disconnect (Shift + F5) Disconnects from NITRO-Viewer.

Settings (F6) Changes NITRO-Viewer settings.

Static Model (Shift + F6) Changes the settings of the model that is statically 
displayed on NITRO-Viewer.

Output the Snapshot Image (F7) Outputs the snapshot image of NITRO-Viewer.

VRAM (F8) Displays the current NITRO-Viewer VRAM content.

Operation Description

Language Settings Switches the display language.

Operation Description

Version Information Displays application version information.
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12.2 Toolbar List
The 3D Material Editor has the following Toolbars:
• Standard Toolbar
• View Toolbar
• Graphics Scene Toolbar
• Object Toolbar
• NITRO-Viewer Toolbar

12.2.1 Standard Toolbar
These correspond to the menu items in the “File” menu, and the “Edit” menu (Figure 12-1, Table 12-1).

Figure 12-1 - Standard Toolbar

Table 12-5 - Standard Toolbar

Button Description

Opens an imd file.

Opens an imd file and merges it with the currently open imd file.

Loads an ica file.

Loads an iva file.

Loads an ima file.

Loads an itp file.

Loads an ita file.

Saves an imd file by overwriting.

Names and saves an imd file.

Undoes an edit.

Redoes an edit.
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12.2.2 View Toolbar
These correspond to “View Mode” items on the “View” menu (Figure 12-2, Table 12-2).

Figure 12-2 - View Toolbar

Table 12-6 - View Toolbar

12.2.3 Graphics Scene Toolbar
These correspond to menu items in the “Graphics Scene” menu (Figure 12-3, Table 12-3).

Figure 12-3 - Graphics Scene Toolbar

Button Description

Sets the Object View display mode to Schematic View.

Sets the Object View display mode to Tree View.

Sets the Object View display mode to Node List View.

Sets the Object View display mode to Polygon List View.

Sets the Object View display mode to Material List View.

Sets the Object View display mode to Texture List View.

Sets the Object View display mode to Palette List View.
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Table 12-7 - Graphics Scene Toolbar

12.2.4 Object Toolbar
These correspond to menu items on the “Object” menu (Figure 12-4, Table 12-4).

Figure 12-4 - Selected Object Toolbar

Table 12-8 - Object Toolbar

Control Description

Switches the Current Graphics Scene.

Creates a new Graphics Scene.

Copies the Current Graphics Scene.

Renames the Current Graphics Scene.

Deletes the Current Graphics Scene.

Imports an isd file, adding a Graphics Scene.

Exports the Current Graphics Scene as an 
isd file.

Button Description

Selects a graphics scene.

Selects a model.

Selects all nodes.

Selects all polygons.

Selects all materials.

Selects all textures.
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12.2.5 NITRO-Viewer Toolbar
These correspond to menu items on the “NITRO-Viewer” menu (Figure 12-5), (Table 12-5)

Figure 12-5 - NITRO-Viewer Toolbar

Table 12-9 - NITRO-Viewer Toolbar

Selects all palettes.

Deselects an object.

Displays an object’s properties in a separate window.

Copies material settings.

Pastes all of the copied material settings.

Selects part of the copied material settings and pastes them.

Button Description

Connects to NITRO-Viewer.

Disconnects from NITRO-Viewer.

Changes NITRO-Viewer settings.

Changes the settings of the model that is statically displayed on 
NITRO-Viewer.

Outputs the snapshot image of NITRO-Viewer.

Displays the current NITRO-Viewer VRAM content.

Button Description
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12.3 Shortcut Key List
The following shortcut keys have been allocated (Table 12-6):
Table 12-10 - Shortcut Keys

Shortcut Key Description

Ctrl + O Opens an imd file.

Ctrl + M Opens an imd file and merges it with the currently open imd file.

Ctrl + S Saves an imd file by overwriting.

Ctrl + A Gives an imd file a name and saves it.

Ctrl + Z Undoes an edit operation.

Ctrl + Y Redoes an edit operation.

Ctrl + 1 Sets the Object View display mode to Schematic View.

Ctrl + 2 Sets the Object View display mode to Tree View.

Ctrl + 3 Sets the Object View display mode to Node List View.

Ctrl + 4 Sets the Object View display mode to Polygon List View.

Ctrl + 5 Sets the Object View display mode to Material List View.

Ctrl + 6 Sets the Object View display mode to Texture List View.

Ctrl + 7 Sets the Object View display mode to Palette List View.

F4 Displays/Hides Property View.

Ctrl + P Displays an object’s properties in a separate window.

Ctrl + Shift + C Copies material settings.

Ctrl + Shift + V Pastes all of the copied material settings.

Ctrl + Shift + S Selects some of the copied material settings and pastes them.

F5 Connects to NITRO-Viewer.

Shift + F5 Disconnects from NITRO-Viewer.

F6 Changes NITRO-Viewer settings.

Shift + F6 Changes the settings of the model that is statically displayed on 
NITRO-Viewer.

F7 Outputs the snapshot image of NITRO-Viewer.

F8 Displays the current NITRO-Viewer VRAM content.

Ctrl + Tab Switches the keyboard focus of the view in the order: object view −> 
property view (tabs) −> property view (contents) −> animation view.

Ctrl + Shift + Tab Switches the keyboard focus of the view in the order: object view −> 
animation view −> property view (contents) −> property view (tabs).
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This package contains software that was developed by the Apache Software Foundation (http://www.apache.org/).
The Apache Software License, Version 1.1
Copyright (c) 1999 The Apache Software Foundation.  All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions 
are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product 

includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment 
may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products derived from this soft-
ware without prior written permission. For written permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written 
permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  
IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDI-
RECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PRO-
CUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUD-
ING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.
====================================================================
This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was 
originally based on software copyright (c) 1999, International Business Machines, Inc., http://www.ibm.com/.
For more, information on the Apache Software Foundation, please see http://www.apache.org/.
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Windows is a registered trademark or trademark of Microsoft Corporation (USA) in the U.S. and other countries.

Maya is a registered trademark or trademark of Alias Systems KK.

Softimage, SOFTIMAGE|3D, SOFTIMAGE|XSI are registered trademarks or trademarks of Avid Technology, Inc. (USA)

3ds max is a trademark or registered trademark both within the United States and internationally, of Autodesk,Inc. / Autodesk 
Canada,Inc

Other company names, product names, etc., in this document are registered trademarks or trademarks of each company.

© 2004-2005 Nintendo

No part of the contents of this document 
may be reproduced, copied, transferred, 
distributed, or given without the permission 
from Nintendo.
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